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Documentation Overview

1 Preface

1.1 Documentation Overview

This section provides an overview of the R&S Signal Generator user documentation.
You find it on the product page at:

http://www.rohde-schwarz.com/product/SMBV100A.html > "Downloads"

Quick start guide

Introduces the R&S Signal Generator and describes how to set up and start working
with the product. Includes basic operations, typical measurement examples, and gen-
eral information, e.g. safety instructions, etc. A printed version is delivered with the
instrument.

Online help

Offers quick, context-sensitive access to the complete information for the base unit and
the software options directly on the instrument.

Operating manual

Separate manuals for the base unit and the software options are provided for down-
load:

® Base unit manual
Contains the description of all instrument modes and functions. It also provides an
introduction to remote control, a complete description of the remote control com-
mands with programming examples, and information on maintenance, instrument
interfaces and error messages. Includes the contents of the quick start guide man-
ual.

® Software option manual
Contains the description of the specific functions of an option. Basic information on
operating the R&S Signal Generator is not included.

The online version of the operating manual provides the complete contents for imme-
diate display on the Internet.
Service manual

Describes the performance test for checking the rated specifications, module replace-
ment and repair, firmware update, troubleshooting and fault elimination, and contains
mechanical drawings and spare part lists.

The service manual is available for registered users on the global Rohde & Schwarz
information system (GLORIS, https://gloris.rohde-schwarz.com).
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Typographical Conventions

Instrument security procedures manual

Deals with security issues when working with the R&S Signal Generator in secure
areas.

Basic safety instructions

Contains safety instructions, operating conditions and further important information.
The printed document is delivered with the instrument.

Data sheet and brochure

The data sheet contains the technical specifications of the software options, see "Digi-
tal Standards for Signal Generators - Data sheet" on the web site. It also lists the
options and their order numbers.

The brochure provides an overview of the instrument and deals with the specific char-
acteristics.
Release notes and open source acknowledgment (OSA)

The release notes of the base units list new features, improvements and known issues
of the current firmware version, and describe the firmware installation.

The open source acknowledgment document provides verbatim license texts of the
used open source software. See the product page of the base unit, e.g. at:

http://www.rohde-schwarz.com/product/SMBV100A.htm| > "Downloads" > "Firmware"

Application Notes, Application Cards, White Papers, etc.

These documents deal with special applications or background information on particu-
lar topics, see http://www.rohde-schwarz.com/appnotes.

1.2 Typographical Conventions

The following text markers are used throughout this documentation:

Convention Description
"Graphical user interface ele- All names of graphical user interface elements on the screen, such as
ments" dialog boxes, menus, options, buttons, and softkeys are enclosed by

quotation marks.

KEYS Key names are written in capital letters.

File names, commands, File names, commands, coding samples and screen output are distin-
program code guished by their font.

Input Input to be entered by the user is displayed in italics.



http://www.rohde-schwarz.com/product/SMBV100A.html
http://www.rohde-schwarz.com/appnotes

Notes on Screenshots

Convention Description

Links Links that you can click are displayed in blue font.

"References" References to other parts of the documentation are enclosed by quota-
tion marks.

1.3 Notes on Screenshots

When describing the functions of the product, we use sample screenshots. These
screenshots are meant to illustrate as much as possible of the provided functions and
possible interdependencies between parameters. The shown values may not represent

realistic test situations.

The screenshots usually show a fully equipped product, that is: with all options instal-
led. Thus, some functions shown in the screenshots may not be available in your par-
ticular product configuration.
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2 Introduction

The R&S Signal Generator enables you to generate signals in accordance with the Sir-
ius satellite radio standard.

The equipment layout of the instrument for generating multicarrier signals includes:

® Option Baseband Main Module (R&S SMx/AMU-B13)

® Options Baseband Generator (R&S SMx/AMU-B9/B10/B11)
Options Baseband Generator (R&S SMx/AMU-B10/B51)
(per signal path)

® Sirius Digital Radio (R&S SMx/AMU-K58)
(per signal path)

Per baseband, one satellite signal or one terrestrial signal can be generated.

2.1 Modulation System Sirius Digital Radio

The Sirus Radio signal is transmitted via two satellites (QPSK-modulation) and addi-
tionally via one terrestrial repeater (COFDM-modulation).
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Figure 2-1: Sirius frequency band

The following table shows the carrier frequencies for the corresponding channels:

Channel Modulation Center Frequency | Bandwidth [MHz] | Notes
[MHZz]
Satellite 1 TDM1 (QPSK) 2322.293 4.51008 Real time
Satellite 2 TDM2 (QPSK) 2330.207 4.51008 Delayed 4.1685
sec (time diversity)
Terrestrial COFDM 2326.250 4.012 Delayed 4.1685
sec (time diversity)
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2.2 Handling of Data Sources

2.2.1 Using Data Lists and Sirius Test Files

For the simulation of Sirius radio, the R&S Signal Generator provides two main data
sources: data lists and Sirius files.

Although any of the standard data sources can be used, the generation of signals in
accordance to the Sirius satellite radio standard requires that the files provided by Sir-
ius satellite radio are used.

The data lists are Rohde&Schwarz proprietary files with extension * . dm_iqgd, that can
be created and modified in the data list editor (see "Data List Management"
on page 14).

The official Sirius test files are provided by Sirius satellite radio. There are two types of
test files currently available in the field: encrypted Sirius test files and the still in use
non-encrypted files. R&S Signal Generator supports both of them.

The non-encrypted test files are the former Sirius test files; they are files with extension
* _tdm and are not provided any more by Sirius satellite radio.

The currently provides test files are encrypted to ensure the usage of the appropriate
files. The encrypted test files are delivered in form of the so called triples, containing an
encrypted test file with extension * . sirius_ igd and two support files with extensions
*.sirus_ subkeyl and *.sirius subkey2 respectively.

by one signal generator manufacturer cannot be decrypted by or used with the signal

6 Each signal generator manufacturer uses it own encrypting procedure.Files encrypted
generators of other manufactures.

There are no Sirius test files installed on the R&S Signal Generator and
Rohde&Schwarz does not provide any Sirius test files. Requesting of encrypted Sirius
test files by Sirius satellite radio is under the responsibility of the customer.

The encrypted triples of Sirius test files and the non-encrypted test files have to be
stored on the hard disk or on a USB flash drive connected to the R&S Signal Genera-
tor. The filenames and the directory they are stored in are user-definable. The files
belonging to a triple must be stored in the same directory (see an example on the fig-
ure below).

Sirius test files can be for instance downloaded via the internet. They are available at
the following page: www.arena.com

) _lists | TFD23T—3.sirius_iqd

= ) _sirius — TFDZST—S.sirius_subkeyl
(] sirius_iqd TFDZ3T-3.sitius_subkeyZ

£ _user | sirius.tdm
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2.2.2 Test Files Handling in the R&S Signal Generator

To play a Sirius test file with the R&S Signal Generator, the corresponding file has to
be selected as a data source for the signal generation. Set the Data Source to "Data
List" and select the required file in theSelect Data List dialog.

The encrypted Sirius test files are decrypted by the R&S Signal Generator in real time
and the decrypted files are not stored on the hard drive of the instrument. Each encryp-
ted file has a timestamp; the expiration date of the test file is displayed on the user
interface (see "Expire Date" on page 15). The test files are rendered unusable after
the expiration date and as long no new license is available. The R&S Signal Generator
informs you with a warning message if the encrypted files are about to expire.

Example:

The license will expire in 23 day(s). |



General Settings

3 Sirius Radio User Interface

—— Satellite Navigation — The dialog for setting the Sirius Radio digital standard is either called from the "Base-

GPS... band" block or from the menu tree under "Baseband".
— Broadcast Standards -

FM-STEREO...

SIRIUS...

XM-RADIO...

selected to illustrate as much as possible of the provided functions and possible inter-

6 The screenshots provided in this description show parameter values that have been
dependencies between them.

These values are not necessarily representative of realistic test situations.

3.1 General Settings

The menu is split into several sections for configuring the standard.

The upper menu section is where the Sirius Radio digital standard is activated and
deactivated. Configuration settings can be stored and already stored configuration set-
tings can be loaded.

B Sirius A

State

| Set To Default | SaveRecall... |

Data List Management... |

In the next section, the physical layer, the physical layer transmission and the data
source are selected.

In the "Terrestrial Parameters" section, the parameters for the terrestrial transponder
are set.

In the "Satellite Parameters" section, the parameters for the satellite transponder are
set.
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Physical Layer I Legacy j
Version Sirius Satellite Radio RX000114-A
Physical Layer Transmission | Satellite 1 j
| Sat 1 Terr Sat 2 |
QPSK QOFDh GRSk
I 2322293 2326.250 2330207 I
2320.0 Frequency MHz 2332.5
Data Source I Data List j
Select Data List... | TFD23T-3.sirius_iqd
Expire Date [dd.mm.yyyy] 14.09.2008
Satellite Parameters
Delay [0.000 000 000 [s -]
Modulation [aPsk -]
HDD Streaming v
Streaming Buffer 0 %

The buttons in the lower menu section lead to submenus for setting the filter, trigger,
and clock parameters.

Filter... | Root Cosine
Trigger/Marker... | Auto

CL g
Clock... | Internal

State
Activates the standard and deactivates all the other digital standards and digital modu-
lation modes in the same path.

Remote command:
[ :SOURce<hw>] :BB:SIRius:STATe on page 37

Set To Default
Calls the default settings. The values of the main parameters are listed in the following

table.

Parameter Value

State Not affected by "Set To Default"
Physical Layer Legacy

Physical Layer transmission Satellite 1

Data Source PN9

HDD streaming On
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Parameter Value

Delay 0.000 s
Modulation QPSK

Filter Root cosine
Rolloff factor 0.20

Symbol Rate variation 3,758 Msym/s

Remote command:
[ :SOURce<hw>] :BB:SIRius:PRESet on page 34

Save/Recall...
Calls the Save/Recall menu.

From the "Save/Recall "menu, the "File Select" windows for saving and recalling Sirius
Radio configurations and the "File Manager" is called.

Recall Sirius Settings
Sawve Sirius Settings
File Manager...

Sirius Radio configurations are stored as files with the predefined file extension
*  sirius. The filename and the directory they are stored in are user-definable.

The complete settings in the "Sirius" menu are saved and recalled.

"Recall Sirius  Opens the "File Select" window for loading a saved Siruis Radio con-
Setting" figuration.
The configuration of the selected (highlighted) file is loaded by press-
ing the "Select" button.

"Save Sirius Opens the "File Select" window for saving the current Sirius Radio
Setting" signal configuration.
The name of the file is specified in the "Filename" entry field. The file
is saved by pressing the "Save" button.
The "Fast Save" checkbox determines whether the instrument per-
forms an absolute or a differential storing of the settings. Enable this
function to accelerate the saving process by saving only the settings
with values different to the default ones. "Fast Save" is not affected
by the "Preset" function.

"File Manager" Calls the "File Manager".
The "File Manager" is used to copy, delete, and rename files and to
create directories.

Remote command:

[ :SOURce<hw>] :BB:SIRius:SETTing:CATalog? on page 35

[ :SOURce<hw>] :BB:STRius:SETTing:LOAD on page 36

[ :SOURce<hw>] :BB:SIRius:SETTing: STORe on page 36

[ :SOURce<hw>] :BB:SIRius:SETTing: STORe: FAST on page 36
[ :SOURce<hw>] :BB:SIRius:SETTing:DELete on page 35
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Data List Management
Calls the "Data List Management" menu. This menu is used to create and edit a data
list.

& Data List Management

I Data List... | dl_siriusl

Edit Data List... | dl_sirius

The data lists are stored as files with the predefined file extension *.dm_1iqgd. The file-
name and the directory they are stored in are user-definable.

To use a data list created in this menu, this data list has to be selected as a data
source in the "Select Data List" submenu.

Remote command:
[ :SOURce<hw>] :BB:SIRius:DATA on page 31
[ : SOURce<hw>] :BB:STRius:DATA:DSELect on page 31

Version
Displays the current version of the Sirius standard depending on the selected Modula-
tion Mode ("Legacy" or "Overlay").

The default settings and parameters provided are oriented towards the specifications
of the version displayed.

Remote command:
[ :SOURce<hw>] :BB:STRius:VERSion? on page 38

Physical Layer
Selects the physical layer mode, i.e. determines whether a legacy or overlay waveform
is generated.

"Legacy" This physical layer mode is used for legacy support, i.e. for generat-
ing of Sirius signals in accordance to the former Sirius Satellite Radio
standard without overlay modulation.

"Overlay" Selects an overlay physical layer mode, i.e. defines the modulation of
the physical layer modes according to the hierarchal overlay modula-
tion.

Remote command:
[ :SOURce<hw>] :BB:SIRius:PLAYer on page 33

Physical Layer Transmission
Selects the physical layer transmission.

"Satellite 1/ Transmits the QPSK-modulated signal.
Satellite 2"

"Terrestrial" Transmits the COFDM-modulated signal.

Remote command:
[ :SOURce<hw>] :BB:SIRius:PLTRansmission on page 33
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Data Source
Selects the data source for the Sirius signal.

The following data sources are available for selection:
"ALLO, ALL1" 0 data and 1 data is generated internally.

"PNxx" PRBS data as per CCITT with period length between (2°-1) and
(223-1) are generated internally.

"Pattern” A user-definable bit pattern with a maximum length of 64 bits is gen-
erated internally.
The bit pattern is defined in the "Data Pattern" entry field.

"Data List" Internal data from a programmable data list is used. The data list can
be generated by the "Data Editor" or generated externally (see Chap-
ter 2.2, "Handling of Data Sources", on page 9).
Data lists are selected in the "Select Data List" field.

Remote command:

[ :SOURce<hw>] :BB:STRius:DATA on page 31

[ :SOURce<hw>] :BB:SIRius:DATA: PATTern on page 33
[ :SOURce<hw>] :BB:SIRius:DATA:DSELect on page 31

Select Data List

Opens a menu to select the data list file and change the content of the transmission.
Only internally generated data lists (* . dm_igd), non-encrypted Sirus test files (* . tdm)
and encrypted Sirius test files (* . sirius_iqgd) are displayed (see Chapter 2.2, "Han-
dling of Data Sources", on page 9).

Remote command:
[ : SOURce<hw>] :BB:SIRius:DATA:DSELect on page 31

Expire Date

Displays the date of the selected test file beyond which the files are rendered unusa-
ble.

The expiration date is displayed in format DD.MM.YYYY.

Remote command:
[ :SOURce<hw>] :BB:SIRius:DATA:EDATe? on page 32

HDD Streaming
Enables/disables the streaming of modulation data direct from the hard drive (HDD).

HDD streaming is recommended for processing of large files that require more ARB
memory than the currently installed one.

Remote command:
[ :SOURce<hw>] :BB:SIRius:DATA:HDDStreaming: STATe on page 33

Streaming Buffer
Displays the filling level of the streaming buffer.

During normal operation, the streaming buffer level has a value between 90% and
100%. Buffer level around 0% indicates that a buffer underruns. It also indicates that
the signal processing is interrupted.
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Adjustment in the parameter value or state usually results in short decreasing of the
streaming buffer level. Do not misunderstand this buffer state as buffer underrun.

Remote command:
[ : SOURce<hw>] :BB:SIRius:DATA:HDDStreaming:BLEVel? on page 32

Delay
Sets the signal delay.

Remote command:
[ :SOURce<hw>] :BB:STIRius:SATellite:DELay on page 34
[ : SOURce<hw>] :BB:SIRius:TERRestrial : DELay on page 37

Modulation
Selects the modulation used for the selected band, depending on the selected "Physi-
cal Layer".

For satellite physical layer, additionally to the default QPSK modulation, 8-PSK and 8-
PSK inverted are available.
The modulation is also displayed in the graphic.

Remote command:
[ :SOURce<hw>] :BB:SIRius:SATellite:MODulation on page 34
[ : SOURce<hw>] :BB:SIRius:TERRestrial :MODulation? on page 37

Overlay Angular Offset
(for "Physical Layer > Overlay")

Sets the overlay angular offset for the 8-PSK and 8-PSK inverted modulation or for the
COFDM modulation, depending on the selected "Physical Layer".

Remote command:
[ :SOURce<hw>] :BB:SIRius:SATellite:0AOFfset on page 35
[ :SOURce<hw>] :BB:STIRius:TERRestrial :OAOFfset on page 38

Filter...
Calls the menu for setting baseband filtering. The current filter is displayed next to the
button.

The menu is described in section Chapter 3.2, "Filter Settings", on page 17.

Remote command:
n.a.

Trigger/Marker
Calls the menu for selecting the trigger mode and trigger source, for configuring the
marker signals, and for setting the time delay of an external trigger signal.

This menu is described in section Chapter 3.3, "Trigger/Marker/Clock Settings",
on page 19.

The currently selected trigger mode and trigger source are displayed next to the but-
ton.

Remote command:
n.a.
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Filter Settings

Execute Trigger
Executes the trigger manually. A manual trigger can be executed only if an internal trig-
ger source and a trigger mode other than "Auto" have been selected.

Remote command:
[ :SOURce<hw>] :BB:STRius:TRIGger:EXECute on page 44

Arm
Stops signal generation manually. The "Arm" button appears only with "Running" sig-
nal generation in the "Armed_Auto" and "Armed_Retrigger" trigger modes

Signal generation can be restarted by a new trigger (internally with "Execute Trigger"
or externally).

Remote command:
[ : SOURce<hw>] :BB:SIRius:TRIGger:ARM: EXECute on page 44

Clock
Calls the menu for selecting the clock source and for setting a delay.

This menu is described in section Chapter 3.3.4, "Clock Settings", on page 27.

Remote command:
n.a.

Filter Settings

To access this dialog, select "Main Menu > Filter".
The baseband filter, sample rate variation and clipping are defined in this menu.

The parameters available in the Filter menu depend on the selected Physical Layer
Transmission.

B Sirius A: Terrestrial Filter Settings E”E”E BE Sirius A; Satellite Filter Settings
Filter Filter
IUsa Sirius Terrestrial Compliant Filter [ | Filter | Root Cosine j
Filter [Lowpass (ACP aptim) -] Roll Off Factor | 0.20
Cut Off Frequency Factor | 050 Symbol Rate Variation | 3.758 400 [ Msyms  ~|
Sample Rate Variation | 6144103125 | Samples’s x|

Use Sirius Terrestrial Compliant Filter

(for "Physical Layer > Transmission")

Activates or deactivates the usage of the filter which is in compliance with the terres-
trial standard.

Remote command:

[ :SOURce<hw>] :BB:SIRius:TERRestrial :FILTer:TCFilter[:STATe]

on page 43

Filter
Sets the baseband filter.
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Remote command:
[ :SOURce<hw>] :BB:STRius:SATellite:FILTer:TYPE on page 39
[ :SOURce<hw>] :BB:SIRius:TERRestrial :FILTer:TYPE on page 39

Rolloff factor / BxT
Sets the filter parameter.

The filter parameter offered ("rolloff factor" or "BxT") depends on the currently selected
filter type. This parameter is preset to the default for each of the predefined filters.

Remote command:
[ :SOURce<hw>] :BB:SIRius:SATellite:FILTer:PARameter:APC0O25

on page 39

[ :SOURce<hw>] :BB:SIRius:SATellite:FILTer:PARameter:COSine
on page 40

[ :SOURce<hw>] :BB:SIRius:SATellite:FILTer:PARameter:GAUSs

on page 40

[ :SOURce<hw>] :BB:SIRius:SATellite:FILTer:PARameter:PGAuUSS
on page 40

[ :SOURce<hw>] :BB:SIRius:SATellite:FILTer:PARameter:RCOSine
on page 41

[ :SOURce<hw>] :BB:SIRius:SATellite:FILTer:PARameter:SPHase
on page 41

[ :SOURce<hw>] :BB:SIRius:TERRestrial :FILTer:PARameter:APC0O25
on page 39

[ :SOURce<hw>] :BB:SIRius:TERRestrial :FILTer:PARameter:COSine
on page 40

[ :SOURce<hw>] :BB:SIRius:TERRestrial:FILTer:PARameter:GAUSs
on page 40

[ :SOURce<hw>] :BB:SIRius:TERRestrial:FILTer:PARameter:PGAuUsSs
on page 40

[ :SOURce<hw>] :BB:SIRius:TERRestrial:FILTer:PARameter:RCOSine
on page 41

[ :SOURce<hw>] :BB:SIRius:TERRestrial:FILTer:PARameter:SPHase
on page 41

Cutoff Frequency Shift
Sets the value for the cutoff frequency shift for a Cosine filter. The cutoff frequency of
the cosine filter can be adjusted to reach spectrum mask requirements.

Remote command:
[ :SOURce<hw>] :BB:SIRius:TERRestrial:FILTer:PARameter:COSine:COFS
on page 42

Cutoff Frequency Factor
Sets the value for the cutoff frequency factor of a Lowpass filter. The cutoff frequency
of the filter can be adjusted to reach spectrum mask requirements.
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Remote command:

[ :SOURce<hw>] :BB:SIRius:SATellite:FILTer:PARameter:LPASs

on page 41

[ :SOURce<hw>] :BB:SIRius:TERRestrial:FILTer:PARameter:LPASs

on page 41

[ :SOURce<hw>] :BB:SIRius:SATellite:FILTer:PARameter:LPASSEVM
on page 42

[ :SOURce<hw>] :BB:SIRius:TERRestrial :FILTer:PARameter:LPASSEVM
on page 42

Symbol Rate Variation
(for "Physical Layer > Transmission")

Sets the symbol rate of the signal. According to the standard, the default value is
3.7584 Msym/s.

Remote command:
[ :SOURce<hw>] :BB:STIRius:SATellite:SRATe:VARiation on page 42

Sample Rate Variation
(for "Physical Layer > Transmission")

Sets the terrestrial sample rate variation.

Remote command:
[ :SOURce<hw>] :BB:SIRius:TERRestrial:SRATe:VARiation on page 42

3.3 Trigger/Marker/Clock Settings

To access this dialog, select "Main Menu > Trigger/Marker".

The "Trigger In" section is where the trigger for the signal is set. Various parameters
are provided for the settings, depending on which trigger source - internal or external -
is selected. The status of signal generation ("Running" or "Stopped") is indicated for all
trigger modes.

Trigger In
Mode | Retrigger |
e Troger | Fovpesc
Source |mmmm |

The "Marker Mode" section is where the marker signals at the MARKER output con-
nectors are configured.
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Marker Mode
Warker 1 |Pattern -] 10.. |
Marker 2 | On/Off Ratio | OnTime | 1[samples -

Off Time | 1| samples  ~|
Marker 3 |Pattern =] 10... |
Warker 4 |Pattern = 0011... |

The "Marker Delay" section is where a marker signal delay can be defined.

Marker Delay
Current Range Without Recalculation

Marker 1 I D.DDDI samples j A ——

LT I D'DDDI Samples j R A R R R
0 2000 Samples
—
LETETD I D'DDDI Samples j R A R R R
0 2000 Samples
A
Warkera | 0.000 | Samples  ~|

0 2000 Samples

Fix Marker Delay To Current Range [~

The "Clock Settings" section is where the clock source is selected and - in the case of
an external source - the clock type.

Clock Settings:

Clock Source Ilntemal vl

The buttons in the last section lead to submenu for general trigger, clock and mapping
settings.

Global Trigger/Clock Settings... |

User Marker | AUX 110 Settings... |

3.3.1 TriggerIn

The "Trigger In" section is where the trigger for the signal is set. Various parameters
are provided for the settings, depending on which trigger source - internal or external -
is selected. The status of signal generation ("Running" or "Stopped") is indicated for all
trigger modes.

Trigger Mode
Selects trigger mode, i.e. determines the effect of a trigger event on the signal genera-
tion.

. llAutoll
The signal is generated continuously.
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® "Retrigger"
The signal is generated continuously. A trigger event (internal or external) causes a
restart.

® "Armed Auto"
The signal is generated only when a trigger event occurs. Then the signal is gener-
ated continuously.
An "Arm" stops the signal generation. A subsequent trigger event (internal with or
external) causes a restart.

® "Armed Retrigger"
The signal is generated only when a trigger event occurs. Then the signal is gener-
ated continuously. Every subsequent trigger event causes a restart.
An "Arm" stops signal generation. A subsequent trigger event (internal with or
external) causes a restart.

® "Single"
The signal is generated only when a trigger event occurs. Then the signal is gener-
ated once to the length specified at "Signal Duration".
Every subsequent trigger event (internal or external) causes a restart.

Remote command:
[ :SOURce<hw>] :BB:SIRius:SATellite[:TRIGger] : SEQuence on page 49
[ :SOURce<hw>] :BB:SIRius:TERRestrial [ :TRIGger] : SEQuence on page 49

Signal Duration
Defines the length of the signal sequence to be output in the "Single" trigger mode.

The input is to be expressed in symbols (for physical layer transmission satellite) or in
samples (for physical layer transmission Terrestrial). It is possible to output deliberately
just part of the signal, an exact sequence of the signal, or a defined number of repeti-
tions of the signal.

The symbol/sample rate depends on the selected physical layer transmission and is
displayed in the corresponding Filter menu. The default symbol/sample rates are as
follows:
® For physical layer transmission satellite

Symbol Rate = 3.758 400 Msym/s
® For physical layer transmission Terrestrial

Sample Rate = 6 144 103.125 Samples/s (with factor 1.5)

Remote command:
[ :SOURce<hw>] :BB:SIRius:SATellite:TRIGger:SLENgth on page 46
[ :SOURce<hw>] :BB:SIRius:TERRestrial:TRIGger :SLENgth on page 48

Running/Stopped
With enabled modulation, displays the status of signal generation for all trigger modes.

® "Running"
The signal is generated; a trigger was (internally or externally) initiated in triggered
mode.

® "Stopped"
The signal is not generated and the instrument waits for a trigger event.

Remote command:
[ :SOURce<hw>] :BB:SIRius:TRIGger :RMODe? On page 44
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Arm
Stops signal generation manually. The "Arm" button appears only with "Running" sig-
nal generation in the "Armed_Auto" and "Armed_Retrigger" trigger modes

Signal generation can be restarted by a new trigger (internally with "Execute Trigger"
or externally).

Remote command:
[ : SOURce<hw>] :BB:SIRius:TRIGger:ARM:EXECute on page 44

Execute Trigger
Executes the trigger manually. A manual trigger can be executed only if an internal trig-
ger source and a trigger mode other than "Auto" have been selected.

Remote command:
[ :SOURce<hw>] :BB:STIRius:TRIGger:EXECute on page 44

Trigger Source
Selects trigger source. This setting is effective when a trigger mode other than "Auto”
has been selected.

® "Internal"
The trigger event is executed by "Execute Trigger".
® "Internal (Baseband A/B)"
(two-path instruments)
The trigger event is the trigger signal from the second path
e "External (Trigger 1/2)"
The trigger event is the active edge of an external trigger signal, supplied at the
TRIGGER 1/2 connector.
Use the "Global Trigger/Clock Settings" dialog to define the polarity, the trigger
threshold and the input impedance of the trigger signal.

Remote command:
[ :SOURce<hw>] :BB:STRius:SATellite: TRIGger: SOURce on page 46
[ :SOURce<hw>] :BB:SIRius:TERRestrial : TRIGger :SOURce on page 48

Sync. Output to External Trigger
(enabled for Trigger Source External)

Enables/disables output of the signal synchronous to the external trigger event.

For or two or more R&S SMBYV that work in a master-slave mode, configure this
parameter depending on the provided system trigger event and the properties of the
output signal. See the table below for an overview of the required settings.
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Table 3-1: Typical applications

System trigger Application "Sync. Output to External Trig-
ger"

Common External Trigger event All instruments are synchronous On
for the master and the slave to the external trigger event
instruments

All instruments are synchronous | Off
among themselves but starting
the signal from first symbol is
more important than synchronicity
with external trigger event

Internal trigger signal of the mas- | All instruments are synchronous | Off

ter R&S SMBYV for the slave among themselves
instruments
"On" Corresponds to the default state of this parameter.

The signal calculation starts simultaneously with the external trigger
event but because of the instrument’s processing time the first sam-
ples are cut off and no signal is outputted. After elapsing of the inter-
nal processing time, the output signal is synchronous to the trigger
event.

| Ext.
| Trigger Event

Calculated
signal

| \/
| Signal at
the output

»—]<&-Processing time—

"Off" The signal output begins after elapsing of the processing time and
starts with sample 0, i.e. the complete signal is outputted.
This mode is recommended for triggering of short signal sequences
with signal duration comparable with the processing time of the
instrument.

| Ext.
| Trigger Event

Calculated
signal

| \/
| Signal at
the output

»—]<&-Processing time—
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Remote command:

[ :SOURce<hw>] :BB:SIRius:SATellite:TRIGger:EXTernal:SYNChronize:
OUTPut on page 50

[ :SOURce<hw>] :BB:SIRius:TERRestrial:TRIGger:EXTernal:
SYNChronize:OUTPut on page 50

Trigger Delay

Delays the trigger event of the signal from:
® The external trigger source

® The other path

Use this setting to:

® Synchronize the instrument with the device under test (DUT) or other external devi-
ces

Remote command:

[ :SOURce<hw>] :BB:SIRius:SATellite:TRIGger[:EXTernal<ch>]:DELay
on page 46

[ :SOURce<hw>] :BB:SIRius:TERRestrial :TRIGger [ :EXTernal<ch>]:DELay
on page 48

[ :SOURce<hw>] :BB:SIRius:SATellite:TRIGger:0BASeband:DELay

on page 45

[ :SOURce<hw>] :BB:SIRius:TERRestrial:TRIGger:0BASeband:DELay

on page 47

Trigger Inhibit

Sets the duration for inhibiting a new trigger event subsequent to triggering. The input
is to be expressed in samples.

In the "Retrigger" mode, every trigger signal causes signal generation to restart. This
restart is inhibited for the specified number of samples.

This parameter is only available on external triggering or on internal triggering via the
second path.

For two-path instruments, the trigger inhibit can be set separately for each of the two
paths.

Remote command:

[ :SOURce<hw>] :BB:SIRius:SATellite:TRIGger [ :EXTernal<ch>]:INHibit
on page 47

[ :SOURce<hw>] :BB:SIRius:TERRestrial :TRIGger[:EXTernal<ch>]:
INHibit on page 49

[ :SOURce<hw>] :BB:SIRius:SATellite:TRIGger:0BASeband: INHibit

on page 45

[ :SOURce<hw>] :BB:SIRius:TERRestrial:TRIGger:0BASeband:INHibit
on page 47

3.3.2 Marker Mode

The marker output signal for synchronizing external instruments is configured in the
marker settings section "Marker Mode".
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The R&S SMBV supports only two markers.

Marker Mode
Selects a marker signal for the associated MARKER output.
"ON/OFF A regular marker signal that is defined by an on/off ratio is generated.
Period" A period lasts one on and off cycle.
The "ON Time" and "OFF Time" are each expressed as a number of
samples.

|ON time OFF time ON time OFF time

Remote command:
[ :SOURce<hw>] :BB:SIRius:SATellite:TRIGger:0UTPut<ch>:0ONTime

on page 53

[ :SOURce<hw>] :BB:SIRius:TERRestrial : TRIGger:0UTPut<ch>:0ONTime
on page 55

[ :SOURce<hw>] :BB:SIRius:SATellite:TRIGger:0OUTPut<ch>:0FFTime
on page 53

[ :SOURce<hw>] :BB:SIRius:TERRestrial :TRIGger:0UTPut<ch>:0FFTime
on page 55

"Frame " A marker signal is generated at the start of each frame.

"Symbol" A marker signal is generated at the beginning of each symbol.

"Symbol within A marker signal is generated at the beginning of a specified symbol
Frame" within a frame.
The symbol is selected with the parameter "Symbol Position".

"User Period" A marker signal is generated at the beginning of every user-defined
period. The period is defined in "Period."

Remote command:
[ :SOURce<hw>] :BB:SIRius:SATellite:TRIGger:0UTPut<ch>:PERiod

on page 54

[ :SOURce<hw>] :BB:SIRius:TERRestrial :TRIGger:O0UTPut<ch>:PERiod
on page 54

"Pulse" A regular marker signal is generated. The pulse frequency is defined

by entering a divider. The frequency is derived by dividing the sample
rate by the divider. The input box for the divider opens when "Pulse"
is selected, and the resulting pulse frequency is displayed below it.

Remote command:

[ :SOURce<hw>] :BB:SIRius:SATellite:TRIGger:0UTPut<ch>:PULSe:
DIVider on page 54

[ :SOURce<hw>] :BB:SIRius:SATellite:TRIGger:0UTPut<ch>:PULSe:
FREQuency? on page 55
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"Pattern " A marker signal that is defined by a bit pattern is generated. The pat-
tern has a maximum length of 32 bits and is defined in an input field
which opens when pattern is selected.

Remote command:

[ :SOURce<hw>] :BB:SIRius:SATellite:TRIGger:0UTPut<ch>:PATTern
on page 54

Remote command:

[ :SOURce<hw>] :BB:SIRius:SATellite:TRIGger:0UTPut<ch>:MODE

on page 53

[ :SOURce<hw>] :BB:SIRius:TERRestrial:TRIGger:O0UTPut<ch>:MODE
on page 53

3.3.3 Marker Delay
The delay of the signals on the MARKER outputs is set in the "Marker Delay" section.

Marker x Delay
Enters the delay between the marker signal at the marker outputs and the start of the
frame or slot.

The input is expressed as a number of symbols/samples. If the setting "Fix marker
delay to dynamic range" is enabled, the setting range is restricted to the dynamic
range. In this range, the delay of the marker signals can be set without restarting the
marker and signal.

Remote command:

[ :SOURce<hw>] :BB:SIRius:SATellite:TRIGger:0UTPut<ch>:DELay
on page 51

[ :SOURce<hw>] :BB:SIRius:TERRestrial :TRIGger:0UTPut<ch>:DELay
on page 51

Current Range without Recalculation
Displays the dynamic range within which the delay of the marker signals can be set
without restarting the marker and signal.

The delay can be defined by moving the setting mark.

Remote command:

[ :SOURce<hw>] :BB:SIRius:SATellite:TRIGger:0UTPut<ch>:DELay:
MINimum? on page 52

[ :SOURce<hw>] :BB:SIRius:TERRestrial:TRIGger:0UTPut<ch>:DELay:
MINimum? on page 52

[ :SOURce<hw>] :BB:SIRius:TERRestrial :TRIGger:0UTPut<ch>:DELay:
MAXimum? on page 52

[ :SOURce<hw>] :BB:SIRius:SATellite:TRIGger:0UTPut<ch>:DELay:
MAXimum? on page 52

Fix marker delay to current range

Restricts the marker delay setting range to the dynamic range. In this range, the delay
can be set without restarting the marker and signal.



3.3.4

Trigger/Marker/Clock Settings

Remote command:

[ :SOURce<hw>] :BB:SIRius:SATellite:TRIGger:OUTPut:DELay:FIXed
on page 51

[ :SOURce<hw>] :BB:SIRius:TERRestrial :TRIGger:OUTPut:DELay:FIXed
on page 51

Clock Settings
The Clock Settings is used to set the clock source and a delay if necessary.

Sync. Mode
(for R&S SMBYV only)

Selects the synchronization mode.

This parameter is used to enable generation of precise synchronous signal of several
connected R&S SMBVs.

Note: If several instruments are connected, the connecting cables from the master
instrument to the slave one and between each two consecutive slave instruments must
have the same length and type.

Avoid unnecessary cable length and branching points.

"None" The instrument is working in standalone mode.

"Sync. Master" The instrument provides all connected instrument with its synchroni-
zation (including the trigger signal) and reference clock signal.

Jock g
ISync Mads | Sync Master :ﬂ

_ Set Synchronisation Settings |

"Sync. Slave"  The instrument receives the synchronization and reference clock sig-
nal from another instrument working in a master mode.

Remote command:

[ :SOURce<hw>] :BB:SIRius:SATellite:CLOCk:SYNChronization:MODE
on page 57

[ :SOURce<hw>] :BB:SIRius:TERRestrial :CLOCk:SYNChronization:MODE
on page 57

Set Synchronization Settings
(for R&S SMBYV only)

Performs automatically adjustment of the instrument's settings required for the syn-
chronization mode, selected with the parameter "Synchronization Mode".

Remote command:

[ :SOURce<hw>] :BB:SIRius:SATellite:CLOCk:SYNChronization:EXECute
on page 58

[ :SOURce<hw>] :BB:SIRius:TERRestrial :CLOCk:SYNChronization:
EXECute on page 58

Clock Source
Selects the clock source.
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"Internal” The internal clock reference is used to generate the symbol clock.

"External" The external clock reference is fed in as the symbol clock or multiple
thereof via the CLOCK connector.
The symbol rate must be correctly set to accuracy of +/-2 % (see data
sheet).
The polarity of the clock input can be changed with the aid of "Global
Trigger/Clock Settings".
In the case of two-path instruments, this selection applies to path A.

Remote command:
[ :SOURce<hw>] :BB:SIRius:SATellite:CLOCk:SOURce on page 57
[ :SOURce<hw>] :BB:SIRius:TERRestrial:CLOCk:SOURce on page 57

Clock Mode

Enters the type of externally supplied clock.

"Sample/ A sample clock (for physical layer transmission Terrestrial) or a sym-

Symbol" bol clock (for physical layer transmission satellite) is supplied via the
CLOCK connector.

"Multiple Sam- A multiple of the sample/symbol clock is supplied via the CLOCK con-

ple/Symbol" nector; the sample clock is derived internally from this.

Remote command:
[ :SOURce<hw>] :BB:STRius:SATellite:CLOCk:MODE on page 56
[ :SOURce<hw>] :BB:SIRius:TERRestrial :CLOCk:MODE on page 56

Clock Multiplier
Enters the multiplication factor for clock type "Multiple".

Remote command:
[ :SOURce<hw>] :BB:STRius:SATellite:CLOCk:MULTiplier on page 56
[ :SOURce<hw>] :BB:SIRius:TERRestrial :CLOCk:MULTiplier on page 56

Measured External Clock
Provided for permanent monitoring of the enabled and externally supplied clock signal.

Remote command:
CLOCk:INPut:FREQuency?

3.3.5 Global Settings

The buttons in this section lead to dialogs for general trigger, clock and mapping set-
tings.

Global Trigger/Clock Settings
Calls the "Global Trigger/Clock/Input Settings" dialog.

This dialog is used among other things for setting the trigger threshold, the input impe-
dance and the polarity of the clock and trigger inputs.

The parameters in this dialog affect all digital modulations and standards, and are
described in chapter "Global Trigger/Clock/Input Settings" in the Operating Manual.
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User Marker / AUX I/O Settings
Calls the "User Marker AUX I/O Settings" dialog, used to map the connector on the
rear of the instruments.

See also "User Marker / AUX I/O Settings" in the Operating Manual.



4 Remote-Control Commands

The following commands are required to perform signal generation with the Sirius
option in a remote environment. We assume that the R&S Signal Generator has
already been set up for remote operation in a network as described in the R&S Signal
Generator documentation. A knowledge about the remote control operation and the
SCPI command syntax are assumed.

For a description of the conventions used in the remote command descriptions, see
section "Remote Control Commands" in the R&S Signal Generator operating manual.

6 Conventions used in SCPI command descriptions

Common suffixes

The following common suffixes are used in remote commands:

Suffix Value range Description
SOURce<hw> [1112 available baseband signals
OUTPut<ch> 1.4 available markers

R&S SMBYV supports two markers

EXTernal<ch> 112 external trigger connectors

The commands in the Source :BB: STRius subsystem are described in the following
section.

Placeholder <root>

For commands that read out or save files in the default directory, the default directory
is set using command MMEM: CDIRectory. The examples in this description use the
place holder <root> in the syntax of the command.

® D:\ -for selecting the internal hard disk of a Windows instrument

® E:\ -for selecting the memory stick which is inserted at the USB interface of a
Windows instrument

® /var/user/ - for selecting the internal flash card of a Linux instrument

® /usb/ - for selecting the memory stick which is inserted at the USB interface of a
Linux instrument.
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Tasks (in manual or remote operation) that are also performed in the base unit in the
same way are not described here.
In particular, this includes:

® Managing settings and data lists, i.e. storing and loading settings, creating and
accessing data lists, accessing files in a particular directory, etc.

® |nformation on regular trigger, marker and clock signals as well as filter settings, if
appropriate.

® General instrument configuration, such as configuring networks and remote opera-
tion
® Using the common status registers

For a description of such tasks, see the R&S Signal Generator operating manual.

The following commands specific to the Source:BB: SIRius subsystem are descri-

bed here:

LI 1= oY = Y=Y a1 T 1 TSR 31
L N 11 =Y T~ 1 o T PRSP 38
O TGO SEHINGS. ..eeiiii ittt 43
®  Marker SEHINGS.....coi i a e e 51
L I O [ Yo QR = 1] o [ 56

4.1 General Settings

[:SOURce<hw>]:BB:SIRius:DATA <Data>

Selects the data source for the Sirius signal.

Parameters:

<Data> ZERO | ONE | PATTern | PN9 | PN11 | PN15 | PN16 | PN20 |
PN21 | PN23 | DLISt
*RST: PN9

Example: BB:SIR:DATA PN9

PNQ9 is the data source for the Sirius signal.

Manual operation: See "Data List Management" on page 14

[:SOURce<hw>]:BB:SIRius:DATA:DSELect <DSelect>
The command selects the data list for the DLISt data source selection.

The lists are stored as files with the fixed file extensions *.dm_iqgd in a directory of the
user's choice. The directory applicable to the following commands is defined with the
command MMEMory : CDIR. To access the files in this directory, you only have to give
the file name without the path and the file extension.
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Parameters:
<DSelect> string
Example: BB:SIR:DATA DLIS

selects Data Lists as data source.
BB:SIR:DATA:DSEL '<root>TFD23T-3'
selects file TFD23T-3.sirius iqd as the data source.

Manual operation: See "Data List Management" on page 14

[:SOURce<hw>]:BB:SIRius:DATA:EDATe?
Queries the date of the selected test file beyond which the files are rendered unusable.

Return values:
<EDate> DD.MM.YYYY

Example: BB:SIR:DATA DLIS

Selects Data Lists as data source.
BB:SIR:DATA:DSEL '<root>TFD23T-3'

Selects the Sirius test file TFD23T-3.sirius_iqgd as the data

source.
BB:SIR:DATA:EDAT?

Queries the expire date.
Response: 14.09.2008

Usage: Query only

Manual operation: See "Expire Date" on page 15

[:SOURce<hw>]:BB:SIRius:DATA:HDDStreaming:BLEVel?
Queries the filling level of the streaming buffer.

During normal operation, the streaming buffer level has a value between 90% and
100%. Buffer level around 0% indicates that a buffer underruns; the signal processing
is interrupted.

Adjustment in the parameter value or state usually results in short decreasing of the
streaming buffer level. Do not mislead this buffer state with buffer underrun.

Return values:

<BLevel> float
Range: 0 to 100
Example: BB:SIR:DATA:HDDS:STAT ON

Enables HDD streaming.
BB:SIR:DATA:HDDS:BLEV?

Queries the streaming buffer level.
Response: 94%

Usage: Query only

Manual operation: See "Streaming Buffer" on page 15
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[:SOURce<hw>]:BB:SIRius:DATA:HDDStreaming:STATe <State>
Enables/disables the streaming of modulation data direct from the hard drive (HDD).

HDD streaming is recommended for processing of large files that require more "ARB
memory" than the currently installed one.

Parameters:
<State> 0]1]OFF|ON
*RST: 1
Example: BB:SIR:DATA:HDDS:STAT ON

Enables HDD streaming.

Manual operation: See "HDD Streaming" on page 15

[:SOURce<hw>]:BB:SIRius:DATA:PATTern <Pattern>

Selects the bit pattern for the Data selection. The maximum length is 64 bits.

Parameters:
<Pattern> 64 bits
Example: BB:SIR:DATA:PATT #B10

defines the bit pattern.

Manual operation: See "Data Source" on page 15

[:SOURce<hw>]:BB:SIRius:PLAYer <Player>

The command selects the physical layer mode for the transmission of the Sirius signal.
Parameters:

<Player> LEGacy | OVERIay

LEGacy
This physical layer mode is used for legacy support

OVERIay

Selects an overlay physical layer mode, i.e. defines the modula-
tion of the physical layer modes according to the hierarchal over-
lay modulation.

*RST: LEGacy

Example: BB:SIR:PLAY LEG
selects legacy physical layer.

Manual operation: See "Physical Layer" on page 14

[:SOURce<hw>]:BB:SIRius:PLTRansmission <PITransmission>

The command selects the physical layer transmission for the transmission of the Sirius
signal.
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Parameters:
<PITransmission> SAT1| SAT2 | TERR

SAT1/SAT2
Transmits the QPSK-modulated signal via up to two satellites.

TERR
Transmits the COFDM-modulated signal.

*RST: SAT1

Example: SOURcel :BB:SIRius:PLTRansmission SAT1
selects SAT1 as physical layer transmission.

Manual operation: See "Physical Layer Transmission" on page 14

[:SOURce<hw>]:BB:SIRius:PRESet

Sets the parameters of the digital standard to their default values (*RST values speci-
fied for the commands).

Not affected is the state set with the command SOURce<hw>:BB:SIRius:STATe.
Example: SOURcel :BB:SIRius:PRESet
Usage: Event

Manual operation: See "Set To Default" on page 12

[:SOURce<hw>]:BB:SIRius:SATellite:DELay <Delay>

Sets the signal delay in physical layer transmission satellite.

Parameters:

<Delay> float
Range: 0to8
Increment: 1E-9
*RST: 0

Example: BB:SIR:SAT:DEL 5.0MS

sets a signal delay of 5 ms.

Manual operation: See "Delay" on page 16

[:SOURce<hw>]:BB:SIRius:SATellite:MODulation <Modulation>
Sets the modulation used in the selected satellite band.
Additionally to the default QPSK modulation, 8-PSK and 8-PSK Inverted are available.

Parameters:
<Modulation> QPSK | PSK8 | PSINV

*RST: QPSK
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Example: SOURcel:BB:SIRius:PLTRansmission SAT1
selects SAT1 as physical layer transmission.
SOURcel:BB:SIRius:SATellite:MODulation QPSK

selects QPSK modulation scheme.

Manual operation: See "Modulation" on page 16

[:SOURce<hw>]:BB:SIRius:SATellite:OAOFfset <OAOffset>
Sets the overlay angular offset for the 8-PSK and 8-PSK Inverted modulation.

Parameters:
<OAOffset> integer
Range: 0 to 20
*RST: 12
Example: SOURcel:BB:SIRius:PLTRansmission SAT1

selects SAT1 as physical layer transmission.
SOURcel:BB:SIRius:SATellite:MODulation P8INV

selects 8-PSK Inverted modulation scheme.
SOURcel:BB:SIRius:SATellite:0AQOFfset 2

sets the overlay angular offset

Manual operation: See "Overlay Angular Offset" on page 16

[:SOURce<hw>]:BB:SIRius:SETTing:CATalog?

This command reads out the files with Sirius settings in the default directory. The
default directory is set using command MMEM: CDIRectory. Only files with the file
extension * . SIRius are listed.

Return values:
<Catalog> string

Example: MMEM:CDIR '<root>SIRIUS'
Sets the default directory.
BB:SIR:SETT:CAT?
Reads out all the files with Sirius settings in the default directory.
Response: 'SIRius 1', 'SIRius '
The files STRius1 and STRius?2 are available.

Usage: Query only

Manual operation: See "Save/Recall..." on page 13

[:SOURce<hw>]:BB:SIRius:SETTing:DELete <Filename>

This command deletes the selected file with "SIRIUS" settings. The directory is set
using command MMEM: CDIRectory. A path can also be specified, in which case the
files in the specified directory are read. The file extension can be omitted. Only files
with the file extension * . SIRius are deleted.
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Setting parameters:
<Filename> string

Example: BB:SIR:SETT:DEL 'SIRius 1'
Deletes file STRius 1.

Usage: Setting only

Manual operation: See "Save/Recall..." on page 13

[:SOURce<hw>]:BB:SIRius:SETTing:LOAD <Filename>

This command loads the selected file with "SIRIUS" settings. The directory is set using
command MMEM: CDIRectory. A path can also be specified, in which case the files in
the specified directory are read. The file extension can be omitted. Only files with the
file extension *. STRius are loaded.

Setting parameters:
<Filename> string

Example: BB:SIR:SETT:LOAD 'SIRius 1'
Loads file SIRius 1.

Usage: Setting only

Manual operation: See "Save/Recall..." on page 13

[:SOURce<hw>]:BB:SIRius:SETTing:STORe <Filename>

This command stores the current "SIRIUS" settings into the selected file. The directory
is set using command MMEM: CDIRectory. A path can also be specified, in which
case the files in the specified directory are read. Only enter the file name. "SIRIUS"
settings are stored as files with the specific file extensions * . STRius.

Setting parameters:
<Filename> string

Example: BB:SIR:SETT:STOR 'SIRius 1'
Stores the current settings into file 'SIRius_1".

Usage: Setting only

Manual operation: See "Save/Recall..." on page 13

[:SOURce<hw>]:BB:SIRius:SETTing:STORe:FAST <Fast>

Determines whether the instrument performs an absolute or a differential storing of the
settings.

Enable this function to accelerate the saving process by saving only the settings with
values different to the default ones.

Note: This function is not affected by the "Preset" function.
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Parameters:
<Fast> 0]1|OFF|ON

*RST: 1

Manual operation: See "Save/Recall..." on page 13

[:SOURce<hw>]:BB:SIRius:STATe <State>

Activates the standard and deactivates all the other digital standards and digital modu-
lation modes in the same path.

Parameters:
<State> 0]1]OFF|ON
*RST: 0
Example: SOURcel:BB:SIRius:STATe ON

Manual operation: See "State" on page 12

[:SOURce<hw>]:BB:SIRius:TERRestrial:DELay <Delay>

Sets the signal delay in physical layer transmission terrestrial.

Parameters:

<Delay> float
Range: 0 to 8
Increment: 1E-9
*RST: 0

Example: BB:SIR:TERR:DEL 5.0MS

sets a signal delay of 5 ms.

Manual operation: See "Delay" on page 16

[:SOURce<hw>]:BB:SIRius:TERRestrial:MODulation?
Queries the modulation used in the selected terrestrial band.

Return values:

<Modulation> COFDM
*RST: COFDM
Example: BB:SIR:LAY TERR

Selects the physical layer transmission.
BB:SIR:TERR:MOD?

Response: COFDM
Usage: Query only

Manual operation: See "Modulation" on page 16



4.2

Filter Settings

[:SOURce<hw>]:BB:SIRius:TERRestrial: OAOFfset <OAOffset>

Sets the overlay angular offset.

Parameters:
<OAOffset> integer
Range: 0 to 20
*RST: 0
Example: BB:SIR:LAY TERR

Selects the physical layer transmission.
BB:SIR:TERR:0AOF 12

Sets the overlay angular offset

Manual operation: See "Overlay Angular Offset" on page 16

[:SOURce<hw>]:BB:SIRius:VERSion?

The command queries the version of the "SIRIUS" standard underlying the definitions.
The displayed version depends on the selected physical layer mode.

Return values:
<Version> string

Example: BB:SIR:VERS?

Queries the SIRIUS version.
Response: "FDSC-608-110000/Ed03/Rev01l"

Usage: Query only

Manual operation: See "Version" on page 14

Filter Settings

[:SOURce<hw>]:BB:SIRius:SATellite:FILTENRTYPE. ....cii et 39
[:SOURce<hw>]:BB:SIRius: TERRestrial:FILTErTYPE.......cccvtvurreriiiiiieieieieeeeeeeeeeeeeeeeeeeeeeens 39
[:SOURce<hw>]:BB:SIRius:SATellite:FILTer:PARameter:APCO25.........cccceeiiiieeiiiieiceeeeeen, 39
[:SOURce<hw>]:BB:SIRius:TERRestrial:FILTer:PARameter:APCO25.........cccoovevuiiiiiinieninns 39
[:SOURce<hw>]:BB:SIRius:SATellite:FILTer:PARameter:COSINe......c...ccevueiiieniirerniieeeneees 40
[:SOURce<hw>]:BB:SIRius:TERRestrial:FILTer:PARameter:COSINe..........ccceevvrenirrrenineennnnnns 40
[:SOURce<hw>]:BB:SIRius:SATellite:FILTer:PARameter:GAUSS...........ccceveiiiiiiiiiiienicceeene, 40
[:SOURce<hw>]:BB:SIRius:TERRestrial:FILTer:PARameter:GAUSS..........cccccvurrrereerraeeeeninn. 40
[:SOURce<hw>]:BB:SIRius:SATellite:FILTer:PARameter:PGAUSS........ccceveeiiiiieiiiiiiiieeeeeenens 40
[:SOURce<hw>]:BB:SIRius:TERRestrial:FILTer:PARameter:PGAUSS...........ccccvevueeirieinneennnnnn. 40
[:SOURce<hw>]:BB:SIRius:SATellite:FILTer:PARameter:RCOSINe.......ccceoveveiiiiiiiiiiiieiceen, 41
[:SOURce<hw>]:BB:SIRius:TERRestrial:FILTer:PARameter:RCOSIne........cccccovevuiirienncrernnnn. 41
[:SOURce<hw>]:BB:SIRius:SATellite:FILTer:PARameter:SPHase..........cccceuiiiiiiiiieiicieennns 41
[:SOURce<hw>]:BB:SIRius:TERRestrial:FILTer:PARameter:SPHase. ........cccceveveccvvvveeeenenenn. 41
[:SOURce<hw>]:BB:SIRius:SATellite:FILTer:PARAMEter:LPASS.........ccevvreiiiiciieieeeeieeeeeennn. 41
[:SOURce<hw>]:BB:SIRius:TERRestrial:FILTer:PARameter:.LPASS........ccccccoevevieeiiieinecennn. 41
[:SOURce<hw>]:BB:SIRius:SATellite:FILTer:PARameter:LPASSEVM..........cccceveeviiiriininnnnnn. 42



Filter Settings

[:SOURce<hw>]:BB:SIRius: TERRestrial:FILTer:PARameter:LPASSEVM.........cccceeeviiiviinennns 42
[:SOURce<hw>]:BB:SIRius:TERRestrial:FILTer:PARameter:COSine:COFS..........c.c.eeevuirernn. 42
[:SOURce<hw>]:BB:SIRius:SATellite:SRATE:VARIAtON. ...ceeviiiiiieiiiaaaaaae e e e e e e eeeeeeeeeeeeeeees 42
[:SOURce<hw>]:BB:SIRius: TERRestrial: SRATe:VARItON. .........cceeceviiiieieieeee e e eeeeenveeeeeen 42
[:SOURce<hw>]:BB:SIRius:TERRestrial:FILTer: TCFilter[:STATE]...cettviiieieeiiieeeeeie e, 43

[:SOURce<hw>]:BB:SIRius:SATellite:FILTer:TYPE <Type>

The command selects the baseband filter type for the satellite physical layer transmis-

sion.

Parameters:

<Type> RCOSine | COSine | GAUSs | LGAuss | CONE | COF705 |
COEQualizer | COFequalizer | C2K3x | APCO25 | SPHase |
RECTangle | PGAuss | LPASs | DIRac | ENPShape |
EWPShape | LPASSEVM
*RST: COSine

Example: BB:SIR:SAT:FILT:TYPE COS

sets the cosine filter type.

Manual operation: See "Filter" on page 17

[:SOURce<hw>]:BB:SIRius:TERRestrial:FILTer:TYPE <Type>

The command selects the baseband filter type for the terrestrial physical layer trans-

mission.

Parameters:

<Type> RCOSine | COSine | GAUSs | LGAuss | CONE | COF705 |
COEQualizer | COFequalizer | C2K3x | APCO25 | SPHase |
RECTangle | PGAuss | LPASs | DIRac | ENPShape |
EWPShape | LPASSEVM
*RST: LPASs

Example: BB:SIR:TERR:FILT:TYPE COS

sets the cosine filter type.

Manual operation: See "Filter" on page 17

[:SOURce<hw>]:BB:SIRius:SATellite:FILTer:PARameter:APC0O25 <Apco25>
[:SOURce<hw>]:BB:SIRius:TERRestrial:FILTer:PARameter:APCO25 <Apco25>

The command sets the roll-off factor for the APCO25 filter type.
Parameters:
<Apco25> float

Range: 0.05 to 0.99
Increment: 0.01
*RST: 0.2



Filter Settings

Example: BB:SIR:TERR:FILT:PAR:APCO25 0.05
the roll-off factor is set to 0.05.

Manual operation: See "Rolloff factor / BxT" on page 18

[:SOURce<hw>]:BB:SIRius:SATellite:FILTer:PARameter:COSine <Cosine>
[:SOURce<hw>]:BB:SIRius:TERRestrial:FILTer:PARameter:COSine <Cosine>

The command sets the roll-off factor for the cosine filter type.

Parameters:
<Cosine> float
Range: 0.05 to 1.0
Increment: 0.01
*RST: 0.05
Example: BB:SIR:TERR:FILT:PAR:COS 0.05

the roll-off factor is set to 0.05.

Manual operation: See "Rolloff factor / BXxT" on page 18

[:SOURce<hw>]:BB:SIRius:SATellite:FILTer:PARameter:GAUSs <Gauss>
[:SOURce<hw>]:BB:SIRius:TERRestrial:FILTer:PARameter:GAUSs <Gauss>

The command sets the BxT for the gauss filter type.

Parameters:
<Gauss> float
Range: 0.15 to 2.5
Increment: 0.01
*RST: 0.5
Example: BB:SIR:TERR:FILT:PAR:GAUS 0.15

the BxT is set to 0.15.

Manual operation: See "Rolloff factor / BXxT" on page 18

[:SOURce<hw>]:BB:SIRius:SATellite:FILTer:PARameter:PGAuss <PGauss>
[:SOURce<hw>]:BB:SIRius:TERRestrial:FILTer:PARameter:PGAuss <PGauss>

The command sets the BxT for the pure gauss filter type.

Parameters:
<PGauss> float
Range: 0.15 to 2.5
Increment: 0.01
*RST: 0.5
Example: BB:SIR:TERR:FILT:PAR:PGA 0.15

the BxT is set to 0.15.

Manual operation: See "Rolloff factor / BxT" on page 18



Filter Settings

[:SOURce<hw>]:BB:SIRius:SATellite:FILTer:PARameter:RCOSine <RCosine>
[:SOURce<hw>]:BB:SIRius:TERRestrial:FILTer:PARameter:RCOSine <RCosine>

The command sets the roll-off factor for the root cosine filter type.

Parameters:
<RCosine> float
Range: 0.05 to 1.0
Increment: 0.01
*RST: 0.22
Example: BB:SIR:TERR:FILT:PAR:RCOS 0.15

the roll-off factor is set to 0.15.

Manual operation: See "Rolloff factor / BXxT" on page 18

[:SOURce<hw>]:BB:SIRius:SATellite:FILTer:PARameter:SPHase <SPhase>
[:SOURce<hw>]:BB:SIRius:TERRestrial:FILTer:PARameter:SPHase <SPhase>

The command sets the BxT for the split phase filter type.

Parameters:
<SPhase> float
Range: 0.15 to 2.5
Increment: 0.01
*RST: 2
Example: BB:SIR:TERR:FILT:PAR:SPH 0.15

the BxT is set to 0.15.

Manual operation: See "Rolloff factor / BXxT" on page 18

[:SOURce<hw>]:BB:SIRius:SATellite:FILTer:PARameter:LPASs <LPass>
[:SOURce<hw>]:BB:SIRius:TERRestrial:FILTer:PARameter:LPASs <LPass>

The command sets the cutoff frequency factor for the Lowpass (ACP optimization) filter

type.
Parameters:
<LPass> float
Range: 0.05 to 2
Increment: 0.01
*RST: 0.5
Example: BB:SIR:TERR:FILT:PAR:LPAS 0.15

The cut of frequency factor is set to 0.15.

Manual operation: See "Cutoff Frequency Factor" on page 18



Filter Settings

[:SOURce<hw>]:BB:SIRius:SATellite:FILTer:PARameter:LPASSEVM

<LPassEvm>
[:SOURce<hw>]:BB:SIRius:TERRestrial:FILTer:PARameter:LPASSEVM
<LPassEvm>
The command sets the cutoff frequency factor for the Lowpass (EVM optimization) fil-
ter type.
Parameters:
<LPassEvm> float
Range: 0.05 to 2
Increment: 0.01
*RST: 0.5
Example: BB:SIR:TERR:FILT:PAR:LPASSEVM 0.15

The cut of frequency factor is set to 0.15.

Manual operation: See "Cutoff Frequency Factor" on page 18

[:SOURce<hw>]:BB:SIRius:TERRestrial:FILTer:PARameter:COSine:COFS <Cofs>

The command sets the "cut of frequency shift' value for the Cosine filter type.

Parameters:
<Cofs> float
Range: -1 to 1
Increment: 0.01
*RST: -0.1
Example: BB:SIR:TERR:FILT:PAR:COS:COFS 0.04

Manual operation: See "Cutoff Frequency Shift" on page 18

[:SOURce<hw>]:BB:SIRius:SATellite:SRATe:VARiation <Variation>

Sets the output symbol rate.

Parameters:
<Variation> integer
Range: 3E6 to S5E6
*RST: 3758400
Example: BB:SIR:SAT:SRAT:VAR 4000000

sets the output sample rate to 4000000 symbols/s.

Manual operation: See "Symbol Rate Variation" on page 19

[:SOURce<hw>]:BB:SIRius:TERRestrial:SRATe:VARiation <Variation>

Sets the output sample rate.



4.3

Trigger Settings
Parameters:
<Variation> float
Range: 6E6 to 6.3E6
Increment: 0.001
*RST: 6144103.125
Example: BB:SIR:TERR:SRAT:VAR 6 144 103.125

sets the output sample rate.

Manual operation: See "Sample Rate Variation" on page 19

[:SOURce<hw>]:BB:SIRius:TERRestrial:FILTer: TCFilter[:STATe] <State>

Activates or deactivates the Sirius filter which is in compliance with the spectral mask
of the terrestrial standard.

Parameters:
<State> 0]1]OFF|ON
*RST: 1
Example: BB:SIR:TERR:FILT:TCF:STAT ON

activates the Sirius terrestrial compliant filter.

Manual operation: See "Use Sirius Terrestrial Compliant Filter" on page 17

Trigger Settings

[:SOURce<hw>]:BB:SIRius: TRIGGErARM:EXECULE.......uuuueeeieieieieeeeieeeeeeeeeeeeeeeeeeeeeessnnennanes 44
[:SOURce<hw>]:BB:SIRIiuS: TRIGGENEXECULE. ....cccetiuiieiieiieiee e e e 44
[:SOURce<hw>]:BB:SIRIius: TRIGENRMODE?.......ciiiiieiiiiaee ettt et e e 44
[:SOURce<hw>]:BB:SIRius:SATellite: TRIGger:OBASeband:DELay.......c...ccceuriieniirieinnieennnnns 45
[:SOURce<hw>]:BB:SIRius:SATellite: TRIGger:OBASeband:INHibit...........cccoeeueiiiiiiiiiiiniennns 45
[:SOURce<hw>]:BB:SIRius:SATellite: TRIGGer:SLENGth...........ccoeriiiiiiieeieeiecce e 46
[:SOURce<hw>]:BB:SIRius:SATellite:TRIGGEr:SOURCE. ......ccvvvuieririeiiiiieieeeeiaiee e eeeeeiniaeeees 46
[:SOURce<hw>]:BB:SIRius:SATellite:TRIGger[:EXTernal<ch>]:DELay......c...cccvuirrrrrrrernnnrann. 46
[:SOURce<hw>]:BB:SIRius:SATellite: TRIGger[:EXTernal<ch>]:INHibit...........cccccevrrriiriennrienn. 47
[:SOURce<hw>]:BB:SIRius:TERRestrial: TRIGger:OBASeband:DELay......c....cccceeeeerniieennnenns 47
[:SOURce<hw>]:BB:SIRius: TERRestrial: TRIGger:OBASeband:INHibit..............cccccevvreeninnnnen. 47
[:SOURce<hw>]:BB:SIRius:TERRestrial: TRIGger:SLENGth........c..ccoveiiiiiiiiiiieiieeee e, 48
[:SOURce<hw>]:BB:SIRius: TERRestrial: TRIGGer:SOURCE...........ccceeeeveiereeeeeieininiinnnnn 48
[:SOURce<hw>]:BB:SIRius:TERRestrial: TRIGger[:EXTernal<ch>]:DELay.......ccc.cceeeeuirenrrennss 48
[:SOURce<hw>]:BB:SIRius:TERRestrial: TRIGger[:EXTernal<ch>]:INHibit..........c....ccoceeeennnins 49
[:SOURce<hw>]:BB:SIRius:SATellite[: TRIGGEr]:SEQUENCE. ... .uuuaaaaaeeeeeeeeeaeeeeeeeeeeeeeeeeeeanes 49
[:SOURce<hw>]:BB:SIRius: TERRestrial[: TRIGger]:SEQUENCE............coeeverrermrmrmrnnnnieiaeeennns 49
[:SOURce<hw>]:BB:SIRius:SATellite: TRIGger:EXTernal:SYNChronize:OUTPuUt.................... 50
[:SOURce<hw>]:BB:SIRius:TERRestrial: TRIGger:EXTernal:SYNChronize:OUTPut................ 50
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[:SOURce<hw>]:BB:SIRius:TRIGger:ARM:EXECute

The command stops signal generation for trigger modes "Armed_Auto" and
"Armed_Retrigger". A subsequent internal or external trigger event restarts the signal

generation.

Example:

Usage:

Manual operation:

BB:SIR:TERR|SAT:TRIG:SOUR INT

Sets internal triggering.

BB:SIR:TERR|SAT:SEQ ARET

Sets Armed_Retrigger mode, i.e. every trigger event causes the
signal generation to restart.

BB:SIR:TRIG:EXEC

Executes a trigger, the signal generation is started.
BB:SIR:TRIG:ARM:EXEC

The signal generation is stopped.

BB:SIR:TRIG:EXEC

Executes a trigger, the signal generation is started again.
BB:SIR:TRIG:RMOD?

Queries the status of signal generation.

Response:

RUN

The signal is generated, the trigger was executed.

Event

See "Arm" on page 17

[:SOURce<hw>]:BB:SIRius:TRIGger:EXECute

The command executes a trigger. The internal trigger source must be selected using
the command :BB:SIR:TERR|SAT:TRIG: SOUR INT and a trigger mode other than
AUTO must be selected using the command :BB: SIR:TERR|SAT: SEQ.

Example:

Usage:

Manual operation:

BB:SIR:TERR|SAT:TRIG:SOUR INT

Sets internal triggering.
BB:SIR:TERR|SAT:SEQ RETR

Sets Retrigger mode, i.e. every trigger event causes signal gen-
eration to restart.
BB:SIR:TRIG:EXEC

Executes a trigger.
Event

See "Execute Trigger" on page 17

[:SOURce<hw>]:BB:SIRius:TRIGger:RMODe?

The command queries the status of signal generation for all trigger modes with Sirius

modulation on.



Return values:
<RMode>

Example:

Usage:

Manual operation:

Trigger Settings

STOP | RUN

RUN

The signal is generated. A trigger event occurred in the triggered
mode.

STOP

The signal is not generated. A trigger event did not occur in the
triggered modes, or signal generation was stopped by the com-
mand SOUR:BB:SIR:TRIG:ARM:EXEC (armed trigger modes
only).

*RST: STOP

BB:SIR:TERR|SAT:TRIG:SOUR EXT

Sets external triggering via the TRIGGER 1 connector.
BB:SIR:TERR|SAT:SEQ ARET

Selects the Armed_Retrigger mode.
BB:SIR:TRIG:RMOD?

Queries the status of signal generation.
Response:

RUN

The signal is generated, an external trigger was executed.
Query only
See "Running/Stopped" on page 21

[:SOURce<hw>]:BB:SIRius:SATellite: TRIGger:OBASeband:DELay <Delay>

The command specifies the trigger delay (expressed as a number of symbols) for trig-
gering by the trigger signal from the second path.

Parameters:
<Delay>

Example:

Manual operation:

float

Range: 0 to 65535

Increment: 0.01

*RST: 0

BB:SIR:SAT:TRIG:SOUR OBAS

sets for path A the internal trigger executed by the trigger signal

from the second path (path B).
BB:SIR:SAT:TRIG:0BAS:DEL 50

sets a delay of 50 symbols for the trigger.

See "Trigger Delay" on page 24

[:SOURce<hw>]:BB:SIRius:SATellite: TRIGger:OBASeband:INHibit <Inhibit>

The command specifies the number of symbols by which a restart is to be inhibited fol-
lowing a trigger event. This command applies only for triggering by the second path.



Parameters:
<Inhibit>

Example:

Manual operation:

Trigger Settings

integer
Range: 0 to 67108863
*RST: 0

BB:SIR:SAT:TRIG:SOUR OBAS
sets for path A the internal trigger executed by the trigger signal

from the second path (path B).
BB:SIR:SAT:TRIG:INH 200

sets a restart inhibit for 200 symbols following a trigger event.

See "Trigger Inhibit" on page 24

[:SOURce<hw>]:BB:SIRius:SATellite: TRIGger:SLENgth <SLength>

Sets the sequence length of the signal in symbols.

Parameters:
<SLength>

Example:

Manual operation:

integer
Range: 1 to 4294967295
*RST: 1

BB:SIR:SAT:TRIG:SLEN 5000
selects the generation of 5000 symbols.

See "Signal Duration" on page 21

[:SOURce<hw>]:BB:SIRius:SATellite: TRIGger:SOURce <Source>

Selects the trigger source.

Parameters:
<Source>

Example:

Manual operation:

INTernal| OBASeband|BEXTernal|[EXTernal

INTernal

manual trigger or *TRG.
EXTernal | BEXTernal

trigger signal on the TRIGGER 1/2 connector.
OBASeband

trigger signal from the other path

*RST: INTernal

SOURcel:BB:SIRius:SATellite:TRIGger:SOURce
EXTernal
sets external triggering via the TRIGGER 1 connector.

See "Trigger Source" on page 22

[:SOURce<hw>]:BB:SIRius:SATellite: TRIGger[:EXTernal<ch>]:DELay <Delay>

The command specifies the trigger delay (expressed as a number of symbols) for

external triggering.



Trigger Settings
Parameters:
<Delay> float
Range: 0 to 65535
Increment: 0.01
*RST: 0
Example: BB:SIR:SAT:TRIG:SOUR EXT

BB:SIR:SAT:TRIG:DEL 50

Manual operation: See "Trigger Delay" on page 24

[:SOURce<hw>]:BB:SIRius:SATellite:-TRIGger[:EXTernal<ch>]:INHibit <Inhibit>

The command specifies the number of symbols by which a restart is to be inhibited fol-
lowing a trigger event. This command applies only in the case of external triggering.

Parameters:

<Inhibit> integer
Range: 0 to 67108863
*RST: 0

Example: BB:SIR:SAT:TRIG:SOUR EXT

BB:SIR:SAT:TRIG:INH 200

Manual operation: See "Trigger Inhibit" on page 24

[:SOURce<hw>]:BB:SIRius:TERRestrial:TRIGger:OBASeband:DELay <Delay>

The command specifies the trigger delay (expressed as a number of samples) for trig-
gering by the trigger signal from the second path.

Parameters:

<Delay> float
Range: 0 to 65535
Increment: 0.01
*RST: 0

Example: BB:SIR:TERR:TRIG:SOUR OBAS

Sets for path A the internal trigger executed by the trigger signal
from the second path (path B).
BB:SIR:TERR:TRIG:0BAS:DEL 50

Sets a delay of 50 samples for the trigger.

Manual operation: See "Trigger Delay" on page 24

[:SOURce<hw>]:BB:SIRius:TERRestrial:TRIGger:OBASeband:INHibit <Inhibit>

The command specifies the number of samples by which a restart is to be inhibited fol-
lowing a trigger event. This command applies only for triggering by the second path.



Parameters:
<Inhibit>

Example:

Manual operation:

Trigger Settings

integer
Range: 0 to 67108863
*RST: 0

BB:SIR:TERR:TRIG:SOUR OBAS
Sets for path A the internal trigger executed by the trigger signal

from the second path (path B).
BB:SIR:TERR:TRIG:INH 200

Sets a restart inhibit for 200 samples following a trigger event.

See "Trigger Inhibit" on page 24

[:SOURce<hw>]:BB:SIRius:TERRestrial:TRIGger:SLENgth <SLength>

Sets the sequence length of the signal in number of samples.

Parameters:
<SLength>

Example:

Manual operation:

integer
Range: dynamic to dynamic
*RST: 1

BB:SIR:TERR:TRIG:SLEN 5000
selects the generation of 5000 samples.

See "Signal Duration" on page 21

[:SOURce<hw>]:BB:SIRius:TERRestrial: TRIGger:SOURce <Source>

The command selects the trigger source.

Parameters:
<Source>

Example:

Manual operation:

INTernal| OBASeband|BEXTernal|[EXTernal

INTernal

manual trigger or *TRG.
EXTernal | BEXTernal

trigger signal on the TRIGGER 1/2 connector.
OBASeband

trigger signal from the other path

*RST: INTernal

SOURcel:BB:SIRius:TERRestrial :TRIGger:SOURce
EXTernal
sets external triggering via the TRIGGER 1 connector.

See "Trigger Source" on page 22

[:SOURce<hw>]:BB:SIRius:TERRestrial:TRIGger[:EXTernal<ch>]:DELay <Delay>

The command specifies the trigger delay (expressed as a number of samples) for

external triggering.



Trigger Settings
Parameters:
<Delay> float
Range: 0 to 65535
Increment: 0.01
*RST: 0
Example: BB:SIR:TERR:TRIG:SOUR EXT

BB:SIR:TERR:TRIG:DEL 50

Manual operation: See "Trigger Delay" on page 24

[:SOURce<hw>]:BB:SIRius:TERRestrial:TRIGger[:EXTernal<ch>]:INHibit <Inhibit>

The command specifies the number of samples by which a restart is to be inhibited fol-
lowing a trigger event. This command applies only in the case of external triggering.

Parameters:

<Inhibit> integer
Range: 0 to 67108863
*RST: 0

Example: BB:SIR:TERR:TRIG:SOUR EXT

BB:SIR:TERR:TRIG:INH 200

Manual operation: See "Trigger Inhibit" on page 24

[:SOURce<hw>]:BB:SIRius:SATellite[: TRIGger]:SEQuence <Sequence>
[:SOURce<hw>]:BB:SIRius:TERRestrial[: TRIGger]:SEQuence <Sequence>

The command selects the trigger mode.



Parameters:
<Sequence>

Example:

Manual operation:

Trigger Settings

AUTO | RETRigger | AAUTo | ARETrigger | SINGle

AUTO
The modulation signal is generated continuously.

RETRigger

The modulation signal is generated continuously. A trigger event
(internal or external) causes a restart.

AAUTo

The modulation signal is generated only when a trigger event
occurs. After the trigger event, the signal is generated continu-
ously. Signal generation is stopped with command
SOUR:BB:SIR:TRIG:ARM:EXEC and started again when a trig-
ger event occurs.

ARETrigger

The modulation signal is generated only when a trigger event
occurs. The device automatically toggles to RETRIG mode.
Every subsequent trigger event causes a restart.

Signal generation is stopped with command
SOUR:BB:SIR:TRIG:ARM:EXEC and started again when a trig-
ger event occurs.

SINGle

The modulation signal is generated only when a trigger event
occurs. Then the signal is generated once to the length specified
with command SOUR:BB:SIR: TERR: TRIG: SLEN. Every sub-
sequent trigger event causes a restart.

*RST: AUTO
BB:SIR:TERR:SEQ AAUT

See "Trigger Mode" on page 20

[:SOURce<hw>]:BB:SIRius:SATellite: TRIGger:EXTernal:SYNChronize:OUTPut

<Output>

[:SOURce<hw>]:BB:SIRius:TERRestrial:TRIGger:EXTernal:SYNChronize:OUTPut

<Output>

(enabled for "Trigger Source" External)

Enables/disables output of the signal synchronous to the external trigger event.

Parameters:
<Output>

Example:

Manual operation:

0] 1| OFF | ON
*RST: 1

BB:SIR:TERR:TRIG:SOUR EXT

Sets external triggering.
BB:SIR:TERR:TRIG:EXT:SYNC:OUTP ON

Enables synchronous output to external trigger

See "Sync. Output to External Trigger" on page 22



Marker Settings
4.4 Marker Settings
[:SOURce<hw>]:BB:SIRius:TERRestrial: TRIGger:OUTPut:DELay:FIXed.........ccceeeevnieeennnnnen. 51
[:SOURce<hw>]:BB:SIRius:SATellite:TRIGger:OUTPut:DELay:FIXed..........ccovevuiiiinrennennnnnn. 51
[:SOURce<hw>]:BB:SIRius:TERRestrial: TRIGger:OUTPut<ch>:DELay......cc...cccvuererruieeeennnnns 51
[:SOURce<hw>]:BB:SIRius:SATellite: TRIGger:OUTPut<ch>:DELay............ccerrrrrrrrrrrrrnrnnnnnnn. 51
[:SOURce<hw>]:BB:SIRius:TERRestrial: TRIGger:OUTPut<ch>:DELay:MAXimum?............... 52
[:SOURce<hw>]:BB:SIRius: TERRestrial: TRIGger:OUTPut<ch>:DELay:MINimum?................. 52
[:SOURce<hw>]:BB:SIRius:SATellite:TRIGger:OUTPut<ch>:DELay:MAXimum?.................... 52
[:SOURce<hw>]:BB:SIRius:SATellite: TRIGger:OUTPut<ch>:DELay:MINimum?............c........ 52
[:SOURce<hw>]:BB:SIRius:SATellite: TRIGger:OUTPut<ch>:MODE..........c.cccoevviriiireieennnnnnn. 53
[:SOURce<hw>]:BB:SIRius:TERRestrial: TRIGger:OUTPut<ch>:MODE.......c....ccccevervuireeennnnns 53
[:SOURce<hw>]:BB:SIRius:SATellite: TRIGger:OUTPut<ch>:OFFTime..........cccevvevuunrieinnnnenn. 53
[:SOURce<hw>]:BB:SIRius:SATellite: TRIGger:OUTPut<ch>:ONTime.......ccccccorrimiririeenraennnen. 53
[:SOURce<hw>]:BB:SIRius:SATellite:TRIGger:OUTPut<ch>:PATTern.....ccccccceeererrireennnenns 54
[:SOURce<hw>]:BB:SIRius:SATellite:TRIGger:OUTPut<ch>:PERIO...........ccevuruiiirireiinnnnnans 54
[:SOURce<hw>]:BB:SIRius: TERRestrial: TRIGger:OUTPut<ch>:PERIOd..........cccuuerieruireennnnnes 54
[:SOURce<hw>]:BB:SIRius:SATellite: TRIGger:OUTPut<ch>:PULSe:DIVider..........cccccevurrnnnns 54
[:SOURce<hw>]:BB:SIRius:SATellite: TRIGger:OUTPut<ch>:PULSe:FREQuency?................. 55
[:SOURce<hw>]:BB:SIRius:TERRestrial: TRIGger:OUTPut<ch>:OFFTime.........cccceveeviireennnnns 55
[:SOURce<hw>]:BB:SIRius:TERRestrial: TRIGger:OUTPut<ch>:ONTIime.........cccevervririernnnnens 55
[:SOURce<hw>]:BB:SIRius:TERRestrial: TRIGger:OUTPut<ch>:SPOSItion..........cccceeereeeene. 56

[:SOURce<hw>]:BB:SIRius:TERRestrial:TRIGger:OUTPut:DELay:FIXed <Fixed>
[:SOURce<hw>]:BB:SIRius:SATellite: TRIGger:OUTPut:DELay:FIXed <Fixed>

Restricts the marker delay setting range to the dynamic range.

Parameters:
<Fixed> 0]1]OFF|ON
*RST: 0
Example: BB:SIR:SAT:TRIG:OUTP:DEL:FIX ON

Manual operation: See "Fix marker delay to current range" on page 26

[:SOURce<hw>]:BB:SIRius:TERRestrial:TRIGger:OUTPut<ch>:DELay <Delay>
[:SOURce<hw>]:BB:SIRius:SATellite: TRIGger:OUTPut<ch>:DELay <Delay>

Defines the delay between the signal on the marker outputs and the start of the signal,
expressed in terms of symbols.

Use the command [ : SOURce<hw>] :BB:SIRius:SATellite:TRIGger:OUTPut:
DELay:FIXed to restrict the range of values to the dynamic range.

Parameters:

<Delay> float
Range: 0 to 2232 - 1 symbols
Increment: 1
*RST: 0
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Example: BB:SIR:SAT:TRIG:0UTP2:DEL 1600
Sets a delay of 1600 symbols for the signal on the second
marker connector.

Manual operation: See "Marker x Delay" on page 26

[:SOURce<hw>]:BB:SIRius:TERRestrial: TRIGger:OUTPut<ch>:DELay:
MAXimum?

[:SOURce<hw>]:BB:SIRius:TERRestrial: TRIGger:OUTPut<ch>:DELay:MINimum?

[:SOURce<hw>]:BB:SIRius:SATellite:TRIGger:OUTPut<ch>:DELay:MAXimum?

[:SOURce<hw>]:BB:SIRius:SATellite: TRIGger:OUTPut<ch>:DELay:MINimum?

Queries the minimum/maximum marker delay for set-
ting :BB:STIRius:SATellite| TERRestrial:TRIGger:0UTPut:DELay:FIXed
ON.

Return values:

<Minimum> float
Range: 0 to max

Example: BB:SIR:SAT:TRIG:0OUTP:DEL:FIX ON
Restricts the marker signal delay setting range to the dynamic
range.

BB:SIR:SAT:TRIG:0UTP:DEL:MIN?

Queries the minimum of the dynamic range.

Response: 0

The minimum for the marker delay setting is 0 symbols.

Usage: Query only

Manual operation: See "Current Range without Recalculation" on page 26
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[:SOURce<hw>]:BB:SIRius:SATellite: TRIGger:OUTPut<ch>:MODE <Mode>
[:SOURce<hw>]:BB:SIRius:TERRestrial:TRIGger:OUTPut<ch>:MODE <Mode>

Parameters:
<Mode>

Example:

Manual operation:

SYMBol | FRAMe | SFRame | USER | RATIo | TRIGger
(for physical layer transmission Terrestrial)

SYMBol

A marker signal is generated at the beginning of each symbol
FRAMe

A marker signal is generated at the beginning of each frame.
SFRame

A marker signal is generated at the beginning of a specified
symbol within a frame. The symbol is selected with the com-
mand [ : SOURce<hw>] :BB:SIRius:TERRestrial:
TRIGger:0OUTPut<ch>:SPOSition on page 56

USER

A marker signal is generated at the beginning of every user-
defined period. The period is defined with the command [ :
SOURce<hw>] :BB:SIRius:SATellite:TRIGger:
OUTPut<ch>:PERiod and [:SOURce<hw>] :BB:SIRius:
TERRestrial :TRIGger:0UTPut<ch>:PERiod.

RATio

A marker signal corresponding to the Time Off / Time On specifi-
cations in the commands [ : SOURce<hw>] :BB:SIRius:
SATellite:TRIGger:0UTPut<ch>:0ONTime and [:
SOURce<hw>] :BB:SIRius:SATellite:TRIGger:
OUTPut<ch>:0FFTime respectively [ : SOURce<hw>] :BB:
SIRius:TERRestrial:TRIGger:OUTPut<ch>:0ONTime and
[ :SOURce<hw>] :BB:SIRius:TERRestrial:TRIGger:
OUTPut<ch>:0FFTime is generated.

TRIGger
A received internal or external trigger signal is output at the
marker connector.

*RST: RATio

BB:SIR:TERR:TRIG:0UTP2:MODE FRAMe
A marker signal is generated at the beginning of each frame.

See "Marker Mode" on page 25

[:SOURce<hw>]:BB:SIRius:SATellite:TRIGger:OUTPut<ch>:0FFTime <OffTime>
[:SOURce<hw>]:BB:SIRius:SATellite: TRIGger:OUTPut<ch>:ONTime <OnTime>

The command sets the number of symbols in a period (ON time + OFF time) during
which the marker signal in setting
SOURce:BB:SIR:SATellite:TRIGger:0UTPut:MODE RATio on the marker out-

puts is ON.
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Parameters:

<OnTime> integer
Range: 1 to 2"24-1 symbols
Increment: 1 symbol
*RST: 1

Example: BB:SIR:SAT:TRIG:0UTP2:0ONT 200

sets an ON time of 200 symbols for marker 2.

Manual operation: See "Marker Mode" on page 25

[:SOURce<hw>]:BB:SIRius:SATellite:TRIGger:OUTPut<ch>:PATTern <Pattern>

Defines the bit pattern used to generate the marker signal in the setting
SOURce:BB:SIRius:SATellite:TRIGger:OUTPut:MODE PATTern. 0 is marker
off, 1 is marker on.

Parameters:
<Pattern> 64 bits
Example: BB:SIR:SAT:TRIG:QUTP2:PATT #B000000011111111,15

sets a bit pattern.
BB:SIR:SAT:TRIG:0UTP2:MODE PATT

activates the marker signal according to a bit pattern on output
MARKER 2.

Manual operation: See "Marker Mode" on page 25

[:SOURce<hw>]:BB:SIRius:SATellite: TRIGger:OUTPut<ch>:PERiod <Period>
[:SOURce<hw>]:BB:SIRius:TERRestrial:TRIGger:OUTPut<ch>:PERiod <Period>

The command sets the repetition rate for the signal at the marker outputs, expressed in
terms of samples.

Parameters:
<Period> integer
Range: 2 to 16777215
*RST: 2
Example: BB:SIR:TERR:TRIG:0UTP2:MODE USER

Selects the user marker

BB:SIR:TERR:TRIG:0UTP2:PER 1600

Sets a period of 1600 samples, i.e. the marker signal is repeated
every 1600th sample.

Manual operation: See "Marker Mode" on page 25

[:SOURce<hw>]:BB:SIRius:SATellite: TRIGger:OUTPut<ch>:PULSe:DIVider
<Divider>

The command sets the divider for Pulse marker mode.
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Parameters:
<Divider> integer
Range: 2 to 1024
*RST: 2
Example: BB:SIR:SAT:TRIG:0UTP2:PULS:DIV 2

Sets the divider to 2 for the marker signal
BB:SIR:SAT:TRIG:0UTP2:FREQ?

Queries the resulting pulse frequency of the marker signal.
Response: 66 000

Manual operation: See "Marker Mode" on page 25

[:SOURce<hw>]:BB:SIRius:SATellite:TRIGger:OUTPut<ch>:PULSe:FREQuency?

Queries the pulse frequency of the pulsed marker signal in the setting
SOURce:BB:SIRius:SATellite:TRIGger:0UTPut:MODE PULSe. The pulse fre-
quency is derived by dividing the symbol rate by the divider.

Return values:

<Frequency> float
Range: 0 to max
Example: BB:SIR:SAT:TRIG:0UTP2:PULS:DIV 2

Sets the divider marker signal to the value 2.
BB:SIR:SAT:TRIG:0UTP2:MODE PULS

Enables the pulsed marker signal.
BB:SIR:SAT:TRIG:0UTP2:PULS:FREQ?
Queries the pulse frequency of the marker signal.
Response: 33 000

The resulting pulse frequency is 33 kHz.

Usage: Query only

Manual operation: See "Marker Mode" on page 25

[:SOURce<hw>]:BB:SIRius:TERRestrial:TRIGger:OUTPut<ch>:0OFFTime
<OffTime>

[:SOURce<hw>]:BB:SIRius:TERRestrial:TRIGger:OUTPut<ch>:ONTime
<OnTime>

Sets the number of samples in a period (ON time + OFF time) during which the marker
signal is on or off.

Parameters:
<OnTime> integer
Range: 1 to 16777215
*RST: 1
Example: BB:SIR:TERR:TRIG:0UTP2:0ONT 200

Manual operation: See "Marker Mode" on page 25
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Clock Settings

[:SOURce<hw>]:BB:SIRius:TERRestrial: TRIGger:OUTPut<ch>:SPOSition
<SPosition>

Sets the symbol within a frame for that a marker signal is generated.

Parameters:
<SPosition> integer

Range: 1 to 1275

*RST: 1
Example: BB:SIR:TERR:TRIG:OUTP:SPOS 200
Clock Settings
[:SOURce<hw>]:BB:SIRius:SATellite:CLOCK:MODE........cccctuiiiiieiieeiieeeeei e 56
[:SOURce<hw>]:BB:SIRius: TERRestrial: CLOCK:MODE.........cccoctuiiiiieiiieeic e eeee e 56
[:SOURce<hw>]:BB:SIRius:SATellite:CLOCK:MULTIPIEI......cvueeeeieiiriieeeeeeeeriieeeeeeeeenieeeeeeens 56
[:SOURce<hw>]:BB:SIRius:TERRestrial: CLOCK:MULTIPHEr.....c.ciiuiiiiieiieieieeeeeeeeeeeees 56
[:SOURce<hw>]:BB:SIRius:SATellite:CLOCK:SOURCE.....c.uiieeeeeieiaeeeeiaeeeeee e e e e e eeieeeeeeeas 57
[:SOURce<hw>]:BB:SIRius: TERRestrial:CLOCK:SOURCE........ccoeeietinuiaeeieiiiiie e eeeeees 57
[:SOURce<hw>]:BB:SIRius:SATellite:CLOCk:SYNChronization:MODE...........ccccceeeeerieeennnnnn. 57
[:SOURce<hw>]:BB:SIRius: TERRestrial: CLOCk:SYNChronization:MODE..............c.ccevernneen. 57
[:SOURce<hw>]:BB:SIRius:SATellite:CLOCk:SYNChronization:EXECUte...........ccevvvenreeeennnnn. 58
[:SOURce<hw>]:BB:SIRius: TERRestrial: CLOCk:SYNChronization:EXECute...........cccceuurannes 58

[:SOURce<hw>]:BB:SIRius:SATellite:CLOCk:MODE <Mode>
[:SOURce<hw>]:BB:SIRius:TERRestrial:CLOCk:MODE <Mode>

Sets the type of externally supplied clock.

For two-path instruments, the only numerical suffix allowed for SOURCce is 1, since the
external clock source is permanently allocated to path A.

Parameters:

<Mode> SAMPle | MSAMple
*RST: SAMPle

Example: BB:SIRius:TERRestrial :CLOC:MODE SAMP
selects clock type Sample, i.e. the supplied clock is a sample
clock.

Manual operation: See "Clock Mode" on page 28

[:SOURce<hw>]:BB:SIRius:SATellite:CLOCk:MULTiplier <Multiplier>
[:SOURce<hw>]:BB:SIRius:TERRestrial: CLOCk:MULTiplier <Multiplier>

Sets the multiplier for clock mode multiple in the case of an external clock source.



Parameters:
<Multiplier>

Example:

Manual operation:

Clock Settings

integer
Range: 1 to 64
*RST: 4

BB:SIR:TERR:CLOC:SOUR EXT

Selects the external clock source. The clock is supplied via the
CLOCK connector.

BB:SIR:TERR:CLOC:MODE MSAM

Selects clock mode "Multiple Sample", i.e. the supplied clock
has a rate which is a multiple of the sample rate.
BB:SIR:TERR:CLOC:MULT 12

See "Clock Multiplier" on page 28

[:SOURce<hw>]:BB:SIRius:SATellite:CLOCk:SOURce <Source>
[:SOURce<hw>]:BB:SIRius:TERRestrial:CLOCk:SOURce <Source>

Selects the clock source.

Parameters:
<Source>

Example:

Manual operation:

INTernal | EXTernal | AINTernal

INTernal

The internal clock reference is used.

EXTernal

(two-path instruments in path A)

The external clock reference is supplied to the CLOCK connec-
tor.

AlINTernal
(two-path instruments in path B)
*RST: INTernal

BB:SIR:TERR:CLOC:SOUR EXT

selects an external clock reference. The clock is supplied via the
CLOCK connector.

BB:SIR:TERR:CLOC:MODE SAMP

specifies that a sample clock is supplied via the CLOCK connec-
tor.

See "Clock Source" on page 27

[:SOURce<hw>]:BB:SIRius:SATellite:CLOCk:SYNChronization:MODE <Mode>
[:SOURce<hw>]:BB:SIRius:TERRestrial:CLOCk:SYNChronization:MODE <Mode>

Selects the synchronization mode.

This parameter is used to enable generation of precise synchronous signal of several
connected R&S SMBVs.

Note:
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If several instruments are connected, the connecting cables from the master instru-
ment to the slave one and between each two consecutive slave instruments must have
the same length and type.

Avoid unnecessary cable length and branching points.

Parameters:

<Mode> NONE | MASTer | SLAVe
NONE
The instrument is working in stand-alone mode.
MASTer
The instrument provides all connected instrument with its syn-
chronization (including the trigger signal) and reference clock
signal.
SLAVe
The instrument receives the system and reference clock signal
and the trigger signal from another instrument working in a mas-
ter mode.
*RST: NONE

Example: BB:SIR:TERR:CLOC:SYNC:MODE MAST

The instrument is configured to work as a master one.

Manual operation: See "Sync. Mode" on page 27

[:SOURce<hw>]:BB:SIRius:SATellite:CLOCk:SYNChronization:EXECute
[:SOURce<hw>]:BB:SIRius:TERRestrial: CLOCk:SYNChronization:EXECute

Performs automatically adjustment of the instrument's settings required for the syn-
chronization mode, set with the command BB: STR: TERR: CLOC: SYNC : MODE.

Example: BB:SIR:TERR:CLOC:SYNC:MODE MAST

The instrument is configured to work as a master one.
BB:SIR:TERR:CLOC:SYNC:EXEC

All synchronization's settings are adjusted accordingly.
Usage: Event

Manual operation: See "Set Synchronization Settings" on page 27



List of Commands

[:SOURCE<hW>]:BB:ISIRIUSIDATA. ...ttt a ettt ettt e bt eme e te e e neeaneeneeaneas 31
[:SOURCe<hw>]:BB:SIRIUS:IDATAIDSELECL.......coiiiiiieiiit ettt e et e e e et e e e e e enaeeeans 31
[:SOURCE<hW>]:BB:SIRIUS:DATAIEDATE? ...ttt ettt ettt ettt b ettt et e s e e beeeneeennes 32
[:SOURce<hw>]:BB:SIRius:DATA:HDDStreaming:BLEVEI?...........ccciiiiiiiiieeeeeeee e 32
[:SOURce<hw>]:BB:SIRius:DATA:HDDStreaming:STATE. ....ccuuiitieiiiiiie ettt 33
[:SOURCE<hW>]:BB:SIRIUS:DATAIPATTEIN. ...ttt ettt ettt ettt e b et eesseeenbeeareeanee 33
[:SOURCEShWS]:BB:ISIRIUS:IPLAY G ... .ottt ettt et e e e 33
[:SOURCce<hw>]:BB:SIRIUS:PLTRANSMISSION.......cciiiiiiiiiiieeitiie ettt et e e eee e e eeeneeeesnneeeennneas 33
[:SOURCE<hW>]:BB:ISIRIUSIPRESEL. ......eeiiiiiiiii ittt ettt et e st e b e snee e s 34
[:SOURce<hw>]:BB:SIRius:SATellite:CLOCK:IMODE..........cciiiiiiiiei e 56
[:SOURce<hw>]:BB:SIRius:SATellite: CLOCK:MULTIPHET. ... .eieeiiiieeceiie et 56
[:SOURce<hw>]:BB:SIRius:SATEllite:CLOCK:SOURGCE. ........ooiuiiiiieiiiaiie ittt 57
[:SOURce<hw>]:BB:SIRius:SATellite:CLOCk:SYNChronization:EXECULE..........cccooveviriiiiiiceieeeceeee 58
[:SOURce<hw>]:BB:SIRius:SATellite:CLOCk:SYNChronization:MODE.............ccccovieeiiiie e 57
[:SOURCce<hw>]:BB:SIRIUS:SATEIIEIDELAY.....ccuiiiiiiiieiiiieiie ittt ettt et 34
[:SOURce<hw>]:BB:SIRius:SATellite:FILTer:PARameter:APCO25...........ccoiiiiiiiieeeee e 39
[:SOURce<hw>]:BB:SIRius:SATellite:FILTer:PARameter:COSine.... ....40
[:SOURce<hw>]:BB:SIRius:SATellite:FILTer:PARameter:GAUSS...........ccciiiiiiieiie it 40
[:SOURce<hw>]:BB:SIRius:SATellite:FILTer:PARameter:LPASS. ..o 41
[:SOURce<hw>]:BB:SIRius:SATellite:FILTer:PARameter:LPASSEVM...........coooiiiiiiie e 42
[:SOURce<hw>]:BB:SIRius:SATellite:FILTer:PARamMEter:PGAUSS.........c.coiiiiiieiiieiieiee e 40
[:SOURce<hw>]:BB:SIRius:SATellite:FILTer:PARameter:RCOSINe..........ccceiviiiiiiiiiiiicceceeeee 41
[:SOURce<hw>]:BB:SIRius:SATellite:FILTer:PARameter:SPHAaSE............cccoiiiiiiiiieicieeeee e 41
[:SOURce<hw>]:BB:SIRius:SATellite:FILTer: TYPE.... ... 39
[:SOURce<hw>]:BB:SIRius:SATellite:MODUIAtION. ........ccueiiiiiiieieeee e 34
[:SOURce<hw>]:BB:SIRIUS:SATEllite:OAOFTSEL.......ccciiieeiiie e e e eneeeeenes 35
[:SOURce<hw>]:BB:SIRius:SATellite:SRATE:VARIGHON. ......coiiiiiiiiiiie e 42
[:SOURce<hw>]:BB:SIRius:SATellite: TRIGger:EXTernal:SYNChronize:OUTPUL...........ccccooiiiiiiiiciiiiees 50
[:SOURce<hw>]:BB:SIRius:SATellite: TRIGger:OBASeband:DELaY............ccccuiiiiiiiiiiieiiicieieceee e 45
[:SOURce<hw>]:BB:SIRius:SATellite: TRIGger:OBASeband:INHIbit..............cccoiiiiiiiiieiiee e 45
[:SOURce<hw>]:BB:SIRius:SATellite: TRIGger:OUTPut:DELay:FIXed........cccooviiiiiiiiieceeeeeeeeeee 51
[:SOURce<hw>]:BB:SIRius:SATellite: TRIGger:OUTPUt<Ch>:DELay.........c.cccceeiiiiiiiiiienieiieeee e 51
[:SOURce<hw>]:BB:SIRius:SATellite: TRIGger:OUTPut<ch>:DELay:MAXimuUM?.........cccceriieiiieiiiieeieeee. 52
[:SOURce<hw>]:BB:SIRius:SATellite: TRIGger:OUTPut<ch>:DELay:MINimumM?..........cccccovrenvrnnineerene 52
[:SOURce<hw>]:BB:SIRius:SATellite: TRIGger:OUTPUt<Ch>:MODE............cccceeiuiiiiiiiieieiieesee e 53
[:SOURce<hw>]:BB:SIRius:SATellite: TRIGger:OUTPUt<ch>:OF FTiMe.........ccciiiiiieiiieie e 53
[:SOURce<hw>]:BB:SIRius:SATellite: TRIGger:OUTPUt<Ch>:ONTIME........cccerriririaiiieicreee e 53
[:SOURce<hw>]:BB:SIRius:SATellite: TRIGger:OUTPUt<Ch>:PATTEM.......ccciiiiiiiiiiiee e 54
[:SOURce<hw>]:BB:SIRius:SATellite: TRIGger:OUTPut<ch>:PERIO...........cccciiiiiiiiiiiaiie e 54
[:SOURce<hw>]:BB:SIRius:SATellite: TRIGger:OUTPut<ch>:PULSe:DIVider...........ccccovueririeriiienciieeens 54
[:SOURce<hw>]:BB:SIRius:SATellite: TRIGger:OUTPut<ch>:PULSe:FREQuency?............cccocevvriiiicicinnns 55

[:SOURce<hw>]:BB:SIRius:SATellite: TRIGger:SLENgth
[:SOURce<hw>]:BB:SIRius:SATellite: TRIGger:SOURce

[:SOURce<hw>]:BB:SIRius:SATellite: TRIGger[:EXTernal<ch>]:DELay..........ccccceeriiriiiniiiiienicee e 46
[:SOURce<hw>]:BB:SIRius:SATellite: TRIGger[:EXTernal<ch>]:INHibit..............cccoooiiiiiiiiiiiiiiic e 47
[:SOURce<hw>]:BB:SIRius:SATellite[: TRIGGer]:SEQUENCE............ccciiiriiiiiiiiiec e 49
[:SOURce<hw>]:BB:SIRIUS:SETTING:CATAIOG?......cciiiiiiiiiieeite ettt 35



[:SOURce<hw>]:BB:SIRIUS:SETTINGIDELELE. .....cccuiiiiiiiiiiiiieiee et 35
[:SOURce<hw>]:BB:SIRius:SETTing:LOAD

[:SOURCe<hw>]:BB:SIRIUS:SETTING:STORE. .....utiieiiiieectiee ettt e see et e e et e e e sneeeesnseeeennseeeaneeeaannes 36
[:SOURce<hw>]:BB:SIRiUS:SETTING:STOREIFAST ...ttt 36
[:SOURCESWS]:BB:SIRIUS:STATE. ...ttt ettt ettt et e e ae e e be e ebe e e e e e eaeeemeeeeneeenbeeeseaenneas 37
[:SOURce<hw>]:BB:SIRius: TERRestrial: CLOCK:IMODE.............coiiiiiiiiie it 56
[:SOURce<hw>]:BB:SIRius: TERRestrial:CLOCK:MULTIPIEN......c..eieiiuiiieciiee e 56
[:SOURce<hw>]:BB:SIRius: TERRestrial:CLOCK:SOURCE. ........ccoiiiiiiiieiii et 57
[:SOURce<hw>]:BB:SIRius: TERRestrial: CLOCk:SYNChronization:EXECULte............ccoooeiriiiniiiiicncceee 58
[:SOURce<hw>]:BB:SIRius: TERRestrial: CLOCk:SYNChronization:MODE............cc..cccooiieiiiieeiiee e 57
[:SOURce<hw>]:BB:SIRiuS: TERRESHAIIDELAY.......c.coiiiiiiiiiiiiie et 37
[:SOURce<hw>]:BB:SIRius: TERRestrial:FILTer:PARameter:APCO25.............oooiiiieiie e 39
[:SOURce<hw>]:BB:SIRius: TERRestrial:FILTer:PARameter:COSine...... ....40
[:SOURce<hw>]:BB:SIRius: TERRestrial:FILTer:PARameter:COSine:COFS............cccoiiiiiiiniiiiicieee 42
[:SOURce<hw>]:BB:SIRius: TERRestrial:FILTer:PARamMeter:GAUSS........ccoviiiieeiieecee e 40
[:SOURce<hw>]:BB:SIRius: TERRestrial:FILTer:PARamMeter:LPASS.........c.cccooiieeiiiieecee e 41
[:SOURce<hw>]:BB:SIRius: TERRestrial:FILTer:PARameter:LPASSEVM..........ccccooi it 42
[:SOURce<hw>]:BB:SIRius: TERRestrial:FILTer:PARamMeter:PGAUSS...........cceeiiiiieiiiieeeiee e 40
[:SOURce<hw>]:BB:SIRius: TERRestrial:FILTer:PARameter:RCOSINE.........c.ccoeiuiieiiiieeiiiie e 41
[:SOURce<hw>]:BB:SIRius: TERRestrial:FILTer:PARameter:SPHase

[:SOURce<hw>]:BB:SIRius: TERRestrial:FILTer: TCFIter[:STATE].....cciieeeiie et
[:SOURce<hw>]:BB:SIRius: TERReSstrial:FILTErTYPE.........ooi oot 39
[:SOURce<hw>]:BB:SIRius: TERRestrial:MODUIAtION?...........ooiiiiiiiiieie e 37
[:SOURce<hw>]:BB:SIRius: TERREStal:OAOFTSEL.......ccueiiiiiiiiiiieie e 38
[:SOURce<hw>]:BB:SIRius: TERRestrial:SRATE:VARIGtION.........cocviiiiiiiecciie e 42
[:SOURce<hw>]:BB:SIRius: TERRestrial: TRIGger:EXTernal:SYNChronize:OUTPUL............cccocoeiiiiiiiiines 50
[:SOURce<hw>]:BB:SIRius: TERRestrial: TRIGger:OBASeband:DELay...
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